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Using This Tutorial

Welcome to the Kurzweil 3000 for Windows Tutorial

This Tutorial is primarily for educators. It may also be 
suitable for users at the high-school level and above. 

Educators may consider using certain chapters/exercises 
as foundation material for student training. 

A Subset of Kurzweil 3000 Features

Although this Tutorial takes a comprehensive look at 
Kurzweil 3000, keep in mind that the features presented 
represent a subset of the features in the Kurzweil 3000 
software. To find details about all the features, use Kurzweil 
3000 online Help pages.
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More Tips Throughout

Throughout the Tutorial, Tips provide suggestions for ways 
to use the features. More to Explore sections highlight other 
options you may want to try. 

This Tutorial is Modular

Each chapter in this Tutorial is modular and presents one 
main topic along with associated features and exercises. 
You can stop at the end of an exercise or a chapter and 
resume at another session, skip around or continue straight 
through. 

This Tutorial Assumes the Following

• You know basic operations in Microsoft Windows®, such 
as file system navigation.

• Kurzweil 3000 Version 11 is installed on your system. 

• You have Kurzweil 3000 for Windows Professional 
edition (Version 11) and a scanner installed if you plan 
on scanning.
2



Using This Guide
What You’ll Need to Complete the Tutorial

The majority of the exercises require certain documents 
from the Sample Documents folder, located in the following 
directory:

C:\Documents and Settings\your user name\My 
Documents\KESI\Kurzweil 3000\Sample Documents

We highly recommend going through Chapter 1, Kurzweil 
3000 Basics, as it contains instructions and information that 
you’ll apply as you work in the Tutorial.

For Technical Support

For Kurzweil 3000 Technical Support call 800-894-5374. If 
you are calling from outside the U.S. or Canada, dial 781-
276-0600.
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1 Kurzweil 3000 
Basics

After reading the first section, The Benefits of Kurzweil 3000 on 
page 7, you’ll learn about the following basic Kurzweil 3000 
functions, many of which you’ll need throughout the Tutorial:

• Starting Kurzweil 3000 on page 9.

• Exploring the Kurzweil 3000 Window on page 10.

• Exiting Kurzweil 3000 on page 12.

• Exploring Kurzweil 3000 Toolbars on page 13.

• Showing and Hiding Toolbars on page 14.

• Exploring the Menu System on page 15.

• Applying a Toolbar Set on page 16.

• Exploring Keyboard Shortcuts on page 17

• Working with Online Help on page 18.
Kurzweil 3000 for Windows Tutorial 5



• Working with Documents in Kurzweil 3000 on page 20.

• Opening and Saving a Document on page 21.

• Enlarging the Document View on page 23.

• Closing a Document on page 24.
6



Chapter 1. Kurzweil 3000 Basics
The Benefits of Kurzweil 3000 
Kurzweil 3000 offers features that benefit both students and teachers.

Kurzweil 3000 enables students to be independent and active learners 
by:

• Supporting language decoding. Kurzweil 3000 provides multi-
sensory learning. Hear and see breaks in syllables, words, 
sentences, phrases or paragraphs as you read.

• Encouraging fluency. Kurzweil 3000 provides opportunities 
for repetition, and for customizing settings to match 
individuals’ current and target reading and learning levels.

• Aiding self-correction. Kurzweil 3000 reads back what’s 
typed, and provides easy-to-use reference and correction 
tools as students read, write, study and take tests.

• Promoting comprehension. Kurzweil 3000 study skills tools 
make it easy to produce many types of notes and summaries 
for review and to create outlines for composing writing 
assignments.

• Supporting knowledge acquisition. Scanning encourages the 
use of a wide range of materials. Word Lists support 
vocabulary building. Read the Web broadens knowledge 
base. Column Notes promote note taking while reading and 
doing research across documents.

• Supporting writing, an important assessment tool for 
teachers. The Kurzweil 3000 Writing Path, including 
Brainstorm, Outline, Draft and Review promote adherence to 
proven writing strategies -- brainstorming, organization and 
revisions.
Kurzweil 3000 for Windows Tutorial 7



The Benefits of Kurzweil 3000
For teachers, Kurzweil 3000 offers quick preparation and 
customization of classroom and test material to meet any curriculum 
objective and educational initiative. You can:

• Provide students with access to a wide range of source 
material from scanned documents to Web pages to online 
books in Kurzweil 3000. 

• Use Notes, color Highlighters and editing tools to automate 
the preparation of pre-reading and active learning aids such 
as vocabulary and question lists.

• Use the Bubble Notes feature to include additional 
instructional support such as prompts, directions and quick 
reading comprehension quizzes.

• Customize, enable and disable toolsets and features to 
accommodate multiple learning requirements and to provide 
a comfortable test-taking environment.

• Customize or create Writing Templates to guide students 
through writing assignments.

• Use or create Word Lists to aid students in writing 
assignments and to promote vocabulary acquisition./
8



Chapter 1. Kurzweil 3000 Basics
Starting Kurzweil 3000
Upon installation, Kurzweil 3000 places an icon on your desktop.

Double-click the Kurzweil 3000 icon.

What You See: The open Kurzweil 3000 window. 

If you are using Kurzweil 3000 Network edition and you see a 
Welcome window, indicating that you are logging on to the 
server, type in your User Name and click OK.

If you are using a Web License, you must have your user name 
and password.
Kurzweil 3000 for Windows Tutorial 9



Exploring the Kurzweil 3000 Window
Exploring the Kurzweil 3000 Window
Have the Kurzweil 3000 window open and take note of its main parts: 

1. Main Menu Bar: Access all Kurzweil 3000 commands and 
features.

2. Toolbar Area: Access frequently used commands and 
features. The default Kurzweil 3000 window displays the 
Main and Reading toolbars.

Note: The Scan feature is available only in the Kurzweil 3000 
Professional edition. If you are using Kurzweil 3000 
Learnstation™, the Scan button is not available.

3. Toolbar Toggles: Click to show or hide the corresponding 
toolbar.

4. Document Window: View documents.

5. Status Bar: View system status.

1
2

3

4

5
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Chapter 1. Kurzweil 3000 Basics
You may also see the Tip of the Day window, such as the one shown 
below.

Note: The Tip of the Day may be disabled in the General Options 
pane, accessible in the Options dialog from the Tools menu.
Kurzweil 3000 for Windows Tutorial 11



Exiting Kurzweil 3000
Exiting Kurzweil 3000
Continue with the Tutorial by going to the next section, which 
discusses the Kurzweil 3000 toolbars. At any time during this Tutorial, 
however, you can exit Kurzweil 3000 by doing one of the following:

• From the File menu in the Main menu bar, choose Exit.
• Or click the Close (X) button in the upper-right-hand corner of 

the Kurzweil 3000 window.
12



Chapter 1. Kurzweil 3000 Basics
Exploring Kurzweil 3000 Toolbars
The most important part of the Kurzweil 3000 window is the toolbar 
area because this is where you access the majority of Kurzweil 3000 
functions.

There are four standard toolbars as well as a set of specialized 
“Sample” toolbars, which you can show, hide, apply or customize. This 
chapter contains exercises for showing, hiding and applying toolbars. 
For information about customizing toolbars, see Kurzweil 3000 online 
Help.

The default Kurzweil 3000 window displays the Main and Reading 
toolbars. You’ll work with other toolbars in later sections.

The Main toolbar lets you access the tasks you perform most often, 
such as reading and opening documents, as well as word lookup. The 
Scan button is only available in Kurzweil 3000 Professional edition.

The Reading toolbar lets you control how Kurzweil 3000 reads. This 
includes the ability to control the speaker; when to pause (reading 
mode); how much text to highlight (reading unit); and the reading 
speed.

There are also some page and document view options. 

This toolbar has function buttons, as well as control buttons and “drop-
down” lists. To show a list, click on the arrow button. To increase or 
decrease the value of a setting, click the up or down control button.

Typical “Drop-down” lists Typical Control Typical Function Buttons
Kurzweil 3000 for Windows Tutorial 13



Showing and Hiding Toolbars
Showing and Hiding Toolbars
In this exercise, you’ll “show” two other standard toolbars: the Study 
Skills and the Writing toolbars.

Showing and hiding toolbars help you to remove clutter from your 
Kurzweil 3000 window and to display only the tools you need for 
specific tasks, such as writing or making annotations.

If you are a teacher, this is one of the simplest ways to customize the 
toolset to accommodate students’ unique requirements.

1. Show and hide the Study Skills toolbar by clicking the green 
toggle.

2. Show and hide the Writing toolbar by clicking the blue toggle.

It’s also possible to use shortcut keys to show and hide toolbars:

• For the Main toolbar, press CTRL+SHIFT+F9.

• For the Reading toolbar, press CTRL+SHIFT+F10.

• For the Study Skills toolbar, press CTRL+SHIFT+F11.

• For the Writing toolbar, press CTRL+SHIFT+F12.

Throughout the Tutorial, you will need certain toolbars. 

Toolbar Toggles
Red: Main Toolbar
Yellow: Reading Toolbar
Green: Study Skills Toolbar
Blue: Writing Toolbar
14



Chapter 1. Kurzweil 3000 Basics
Exploring the Menu System
The Main menu bar contains all Kurzweil 3000 functions and features. 
Many of the functions and features in menus are also available as 
toolbar buttons.  

There are also shortcut (right mouse button) menus throughout the 
program. Let’s take a look at a shortcut menu.

1. Place your cursor in an empty spot in the toolbar or menu 
area.

2. Click the right mouse button to show the Toolbar shortcut 
menu.

An arrow next to a menu item indicates that there is a submenu. 
Ellipses (...) indicate that there is a dialog box.
Kurzweil 3000 for Windows Tutorial 15



Applying a Toolbar Set
Applying a Toolbar Set
On the Toolbar shortcut menu, under Apply Toolbar Set there are 
additional toolbar sets that you can use for a variety of situations. 

For instance, in test-taking situations, you may opt to show the Test 
Taking toolbar set, providing only the tools students need to 
accomplish test-taking tasks.

To display the Toolbar shortcut menu, place the cursor in the toolbar 
area and click the right mouse button.

To return to the default toolbars, on the Toolbar shortcut menu, 
choose Apply Toolbar Set, then select Classic.

Note: It’s possible to save a toolbar with a document. For more 
information, see Saving the Toolbar with the Test Document on page 189.
16



Chapter 1. Kurzweil 3000 Basics
Exploring Keyboard Shortcuts
Throughout Kurzweil 3000, there are keyboard shortcuts—function 
keys or combinations of keys that you can press to make selections or 
execute commands. Kurzweil 3000 supports typical Windows 
shortcuts, such as CTRL+O to open a file, as well as Kurzweil 3000 
ones, such as CTRL+K to magnify words.

1. Try pressing CTRL+F1 to open the Options dialog.

2. A quick way to make a selection is to find an underlined letter 
in the selection you want, then press ALT plus that letter’s 
key. For instance, all dialogs in Kurzweil 3000 have a Help 
button which, when selected, displays Help pages. Press 
ALT+H now to open the Help page.

3. When you’re done, press ALT+F4 to close the Help page.

4. Press ALT+C to close the Options dialog.

For a list of keyboard shortcuts, see Kurzweil 3000 online Help.
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Working with Online Help
Working with Online Help
You should also know how to access Help. In this exercise, you’ll 
explore the Kurzweil 3000 Help pages. Keep in mind that you also can 
find Help in dialog boxes.

1. Click the Help button in the Main toolbar to open the Help 
Home page.

What You See: The Help Home page.

Notice the Search box and button, which allows you to 
search by keyword or phrase.

2. Kurzweil 3000 online Help pages work like web links. To go 
to a topic, click the blue, underlined text. 

Search 
keywords

Go to topics
Go to Index

Home Read
Print

Change font size

Back to Kurzweil 
3000 window
18



Chapter 1. Kurzweil 3000 Basics
3. Try any of the following: 

• Click a text topic in the left pane. The topic page 
should appear in the right pane.

• Click in the Search box and type “keyboard shortcuts,” 
then press ENTER. A list of topics containing those 
keywords should appear in the left pane. Double-click 
a text topic to display the page in the right pane.

4. To read the contents of a page, click the Read button.

5. When you’re done, close the Help pages by clicking the 
Close button.
Kurzweil 3000 for Windows Tutorial 19



Working with Documents in Kurzweil 3000
Working with Documents in Kurzweil 3000
You can work with almost any type of document in Kurzweil 3000, 
allowing you to access and use any printed material.

Image documents are documents that have image text and/or 
graphics. When you scan in pages, bring a document into Kurzweil 
3000 by using the KESI Virtual Printer or open a TIFF file in Kurzweil 
3000, you are working with image documents. These documents 
contain the image that you see on the screen, and “underlying text,” 
which is the text that the program “recognized,” and which Kurzweil 
3000 reads. It’s possible to edit the underlying text to fix recognition 
errors so that Kurzweil 3000 reads text correctly.

In image documents, you can use Reading, Reference, Study Skills 
(including Notes, Color Highlighters and Text Circles) and Test Taking 
tools.

You’ll use an image document in the next section, Opening and Saving 
a Document.

Text documents are documents that contain text only. You can create 
a text document by typing text into a new Kurzweil 3000 document or 
by extracting text, annotations or highlighted text. You can also open 
an existing text file or import it.

In text documents, you can use Reading, Reference, certain Study 
Skills, and Writing and Editing tools.

You’ll create a text document in Creating a Text Document on page 128.
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Chapter 1. Kurzweil 3000 Basics
Opening and Saving a Document
In this exercise, you’ll open a document and save it under a different 
name so that you can work with the newly saved document later in the 
Tutorial. You’ll need to do this procedure frequently throughout the 
Tutorial.

1. Click the Open button in the Main toolbar.

To use the keyboard shortcut, press CTRL+O.

2. In the “Kurzweil 3000” folder, find and double-click the 
“Sample Documents” folder. You can use the TAB key and 
the ARROW keys to navigate the dialog as you would any 
Windows dialog.

What You See: The contents of the Sample Documents 
folder.

3. Navigate to the desired file name to open it; in this case, 
“Time Travel.” Double-click the file to open it.

4. From the File menu, choose Save As. 

5. In the Save As dialog that appears, click the beginning of 
the file name.

6. Type “my.”

7. Click the Save button.

To use the keyboard shortcut, press CTRL+S.
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Opening and Saving a Document
What You See: A copy of the document with the new name. 
Check the top of the Kurzweil 3000 window to see the new file 
name.

8. Keep this document open and continue to the next 
exercise to enlarge the document view.
22



Chapter 1. Kurzweil 3000 Basics
Enlarging the Document View
Enlarging the document view can increase readability.

What You’ll Need to Do This Exercise: The “my Time Travel” 
document that you saved and opened in Kurzweil 3000 in the previous 
exercise.

1. Click the up or down Zoom buttons in the Reading toolbar 
to make the document larger or smaller.

2. Try other options, if you like. 

3. Continue to the next exercise to Close the document.
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Closing a Document
Closing a Document
There are three ways to close the document. You can:

• From the File menu, choose Close.

• Use the keyboard shortcut by pressing CTRL+F4.

• Click the second Close button at the top right 
corner of the Kurzweil 3000 window. (Clicking the top-
most Close box closes the Kurzweil 3000 window and 
stops the program.)

You’re now ready to continue to the next chapter, where you’ll 
learn about document preparation.
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2 Document 
Preparation

This chapter presents the document preparation process. 
You’ll scan a document to bring it into Kurzweil 3000 and 
explore a couple of features that aid in the preparation of the 
material for reading. Note that many of the features 
presented in this chapter, such as Scanning and Zone 
Editing, are available only in Kurzweil 3000 Professional 
edition.

Because this chapter takes you through a multi-featured 
process, you may opt to preview it, then go directly to 
Chapter 3, and return to these exercises when you have 
gained confidence in using Kurzweil 3000.

In this chapter, you’ll learn about:

• The Document Preparation Process on page 27.

• Scanning a Document into Kurzweil 3000 on page 31. 
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• Reading as Part of Document Preparation on page 33. 

• Changing the Reading Order Using the Zone Editor on page 35.

• Changing an Underlying Word on page 46. 

You’ll also find more scanning information in More to Explore: 

Trying Other Scanning Features on page 48.
26



Chapter 2. Document Preparation
The Document Preparation Process
There are three main steps in the Kurzweil 3000 document 
preparation process:

• Step 1: Bring material into Kurzweil 3000. The material can 
be anything from a worksheet created in Microsoft Word, to a 
test, to entire textbook sections, to electronic files and 
content. You can do this by scanning pages, opening files 
created in other software, as well as by saving pages from the 
Web or by downloading files from online sources.

• Step 2: Read through the document to determine whether or 
not it is reading the way you want it to. For example, are there 
mispronunciations? Does the reading order make sense? 

• Step 3: Make the desired changes using Kurzweil 3000 
recognition correction and editing tools, such as the 
Underlying Text Editor and the Zone Editor.

When you scan a document into Kurzweil 3000, it becomes a Kurzweil 
3000 image file, with the following results:

• It displays the image of the text on the screen and retains the 
text from the optical character recognition (“recognition”) 
process “under” the image. This “underlying text” is what 
Kurzweil 3000 reads.

• Because character recognition is not always exact, the 
underlying text may contain character errors and 
mispronunciations. (Note that mispronunciations may also be 
the result of the selected reading voice.)
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The Document Preparation Process
• Kurzweil 3000 separates each chunk of recognized text into 
zones that you can re-order, delete, or choose to not have 
Kurzweil 3000 read.

You can customize how Kurzweil 3000 reads text by using the Zone 
Editor, which is what you will do later in this chapter. 

You can correct mispronunciations and recognition errors in a number 
of ways, as noted below. For step-by-step procedures on any of the 
following features, see Kurzweil 3000 online Help.

• For mispronunciations that are the result of your reading 
voice, use the Pronunciations dialog, accessible from the 
Tools menu.
28



Chapter 2. Document Preparation
• To correct a frequently occurring recognition error, add it to 
the Corrections list, accessible from the Scan menu.

• To correct a single recognition error, you can use Change 
Underlying Word, accessible when you choose Correct 
Recognition from the Edit menu.

• To correct multiple recognition errors, you can use typical 
editing tools such as Spell Checking, and Find and Replace 
or Edit Underlying Text, accessible when you choose 
Correct Recognition from the Edit menu. 
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The Document Preparation Process
• To add material that did not get recognized, you can use the 
Override OCR option, accessible from the Zone Editor 
Properties dialog after you have added a zone.

• To have Kurzweil 3000 not read headers, footers or any text 
that appears in the same location throughout a document, 
select Header/Footer Editor from the Scan menu.
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Chapter 2. Document Preparation
Scanning a Document into Kurzweil 3000
The curriculum material you use most often comes in print format. To 
provide your students with access to these documents, you can scan 
the material into Kurzweil 3000. 

You can scan multiple pages as well as scan newspaper and table 
layouts if you have Kurzweil 3000 Professional edition. With Kurzweil 
3000 Professional Color, you can also scan in color.

Keep in mind that you can also teach students to scan their own 
material.

In this exercise, you’ll do a simple scan in black and white.

What You’ll Need to Do This Exercise:
• Kurzweil 3000 Professional edition and a properly installed 

scanner.

• A document to scan. In this case, use the Kurzweil 3000 
Scanning Sample on page 207. This exercise shows you the 
results of scanning that page.

• The open Kurzweil 3000 window.

1. Place the document face down on the scanner.

2. In the Kurzweil 3000 Main toolbar, click the Scan button.

The keyboard shortcut for starting a new scan is F9.
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Scanning a Document into Kurzweil 3000
What You See: The image of the document. Note that aspects 
of your scanned document, such as the page number may 
differ from the illustrations in this Tutorial. 

3. Save and rename the document:

Click the Save button in the Main toolbar to display the 
Save As dialog. Rename the document “Scan Sample,” 
then click Save. 

4. If you are exploring the document preparation process, 
continue to the next exercise, Reading as Part of 
Document Preparation.
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Chapter 2. Document Preparation
Reading as Part of Document Preparation
In preparing a document for students, it’s important to read through it 
after bringing it into Kurzweil 3000. 

As you read through the document:

• Notice the order in which Kurzweil 3000 reads the material. 
This is the ideal time to consider whether you want to change 
the reading order or have Kurzweil 3000 not read certain 
chunks of text. You can change the reading order using the 
Zone Editor from the Scan menu.

• Listen for mispronunciations, which are an indication that 
there are recognition errors and that you’ll need to change 
how Kurzweil 3000 reads the text. One way to correct 
recognition errors is to use Correct Recognition from the 
Edit menu.

What You’ll Need to Do This Exercise: 
• The open Kurzweil 3000 window.

• An open document in the Kurzweil 3000 window. You can use 
the Scanning Sample page from the previous exercise. 

1. In the document you are preparing, click where you want 
to start reading, then in the Main toolbar, click the Read 
button. To use the keyboard shortcut to start reading, press 
F3.

If you are using the “Scan Sample.kes” document from the 
previous exercise, click before the title, then click Read.
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Reading as Part of Document Preparation
2. Go through the document and listen for mispronunciations, 
and reading order.

What You Hear: If you are using the Scanning Sample page, 
one possible error is the mispronunciation of the word “Tavi” in 
the footer.

Note: Because each recognition process produces unique 
results, the errors you encounter may be different from what’s 
presented in this Tutorial.

3. If you are exploring the document preparation process, 
continue to the next exercise, Changing the Reading Order 
Using the Zone Editor on page 35.
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Changing the Reading Order Using the Zone 
Editor
When you scan documents into Kurzweil 3000, the program 
recognizes blocks of text from the original, including page numbers, 
footnotes, captions and sidebars, as individual “zones.” 

When Kurzweil 3000 reads the document, it reads everything it 
recognizes and reads the zones in the order in which they appear. 
This may not be the preferred or ideal reading order. For instance, 
suppose there is a sidebar on the page. You may want Kurzweil 3000 
to read the sidebar contents after reading the primary text, not before. 

If you determine that your document could benefit from changing 
reading order or from having Kurzweil 3000 not read certain text, use 
the Zone Editor to re-order the zones. It’s best to do this before you 
perform other editing tasks.

In this exercise, you’ll change the reading order of zones and hear the 
results.

To do this exercise, use the “Scan Sample.kes” file you scanned in a 
previous exercise.

The screen shots in this exercise are of “Scan Sample.kes.”

Note: Because each recognition process produces unique results, the 
results you encounter may be different from what’s presented in this 
Tutorial.
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Changing the Reading Order Using the Zone Editor
1. From the Scan menu, select Zone Editor.

If you find that you need frequent access to this command, 
consider committing its keyboard shortcut, CTRL+F5, to 
memory.
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Chapter 2. Document Preparation
What You See: The document in Zone Edit mode. Each text 
block is a separate, yellow-highlighted “zone” with an assigned 
number indicating reading order.

By default, all zones are Primary Text zones, meaning they 
are read in reading order, left to right and down the page. 

It’s possible to change a zone to Secondary Text, which is not 
read unless the reader clicks it, or to Graphic, which Kurzweil 
3000 treats as art and does not read.
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Changing the Reading Order Using the Zone Editor
2. Change a zone to Secondary Text (in this case, zone 2, 
the sidebar text).

Click the desired zone, then click the right mouse button to 
display the Zone Editor shortcut menu. Select Properties.
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Chapter 2. Document Preparation
What You See: The selected zone’s color dims and the Zone 
Properties dialog opens.

3. Select Secondary Text, then click OK.

Zone 2, 
Selected
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Changing the Reading Order Using the Zone Editor
What You See: The zone number changes and the color of the 
changed zone is now green.

Zone Number 
Changed
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Chapter 2. Document Preparation
4. Change a zone’s property to Graphic (in this case, zone 
number 4), containing the page number. 

This setting directs Kurzweil 3000 to not read the zone.

Click the desired zone, then click the right mouse button to 
show the Zone Editor shortcut menu. 

Select Properties.

In the Zone Properties dialog, click Graphic. 

Click OK.

What You See: The zone color changes to light blue, and 
there is no longer an associated zone number.

Current Zone Number 
for Selected Zone
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Changing the Reading Order Using the Zone Editor
What You See: In addition, notice that other zones may have 
been renumbered. If you have been following along with this 
document, the zone that you marked as a secondary zone 
earlier now has a different zone number, in this case, 4.

Graphic Zone with 
No Zone Number

Zone 
Renumbered
42



Chapter 2. Document Preparation
5. Re-order a zone. 

Click on the desired zone (in this case, zone 3 in the 
footer), then hold down the right mouse button to show the 
Zone Editor shortcut menu. 

Select Properties.

In the Zone Properties dialog, click in the Reading Order 
box and type “1.” 

Click OK.

Change 
Reading Order
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Changing the Reading Order Using the Zone Editor
What You See: Renumbered zones throughout the document.

6. When you’re done with zone editing, display the Zone 
Editor shortcut menu, then click Zone Editor to deselect 
it, or press CTRL+F5.

7. In the message that appears, click Yes.

What You See: The document in its original view.

8. Click Read to hear how the zone editing affected the 
reading order. 
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Chapter 2. Document Preparation
What You Hear: If you have been following along with the 
Scanning Sample document and have made all the changes in 
the previous exercise, you hear Kurzweil 3000 read the footer 
first, the title next, then the body. 

It skips the sidebar text because it is labeled as Secondary 
Text. To hear Secondary Text, you must click at the beginning 
of the text and click Read.

Notice that Kurzweil 3000 does not read the page number.

9. If you want to end here, you may Save the document and 
Close it; otherwise continue to the next exercise.
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Changing an Underlying Word
Changing an Underlying Word
When you scan a document, it goes through a recognition process. 
Kurzweil 3000 displays the image of the text on the screen and retains 
the text from the optical character recognition (“recognition”) process 
“under” the image. 

There may be times when the process produces errors. For example, 
a common error is mistaking the letter “i” for the letter “l.”

If you scanned in the Scanning Sample page earlier and read through 
it, you may have heard just such an error in the word “Tavi” in the 
footer. Kurzweil 3000 may have read “Tavl” instead of “Tavi.”

In this exercise, you’ll change the underlying text for that word.

Note: Because each recognition process produces unique results, the 
errors you encounter may be different from what’s presented in this 
Tutorial.

What You’ll Need to Do This Exercise: 
• The “Scan Sample.kes” document open in Kurzweil 3000.

• A possible recognition error. If there aren’t any in your 
document, it’s OK to use any word to gain some practice 
through this exercise; just remember not to save the changes 
you make. 

1. Click the word “Tavi” in the footer.
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Chapter 2. Document Preparation
2. From the Edit menu, choose Correct Recognition, then 
choose Change Underlying Word or use the shortcut 
keys CTRL+W.

What You See: The Change Underlying Word dialog with 
the underlying text, spelled “Tavl.” Keep in mind that this is the 
recognized text and the text that you hear Kurzweil 3000 read.

3. Click inside the Replace with box, and type “Tavi” (with the 
letter “i” at the end).

4. Check to ensure the word is read correctly by clicking 
Read.

5. Click OK.

6. Save the document, if you want, and Close it. 
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More to Explore: Trying Other Scanning Features
More to Explore: Trying Other Scanning 
Features
While there are several more features on the Scan menu, you may 
want to try some of the following.

For more information, go to Kurzweil 3000 online Help.

Problem or Type of Scan: Use:

Scan multiple pages when 
scanning using the flatbed.

Scan Repeatedly to add a new 
page after the current page in the 
scanned document.

Rescan. Rescan Page to replace the 
current scanned page with the 
new scanned page.

Insert a page. Insert Page to insert a new 
scanned page before the current 
page.

Delete a page. Delete Page to remove the 
current page.

Scan a color document. Use Color to scan in color.
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Chapter 2. Document Preparation
Teaching and 
Learning Tips

Once you have the document brought in and edited for 
recognition errors and reading order, consider the 
following:

• Use Notes and/or instructions for students. See 
Chapter 5, Notes and the Creation of a Study Document.

• Use highlighters to help readers identify types and 
levels of information. See Chapter 6, Color Highlighters 
as Study Tools.

• Extract highlights to create quick study guides. See 
Chapter 6, Color Highlighters as Study Tools.

• Use the Send To Email feature to send documents 
home from Kurzweil 3000 through e-mail. Find 
details in Kurzweil 3000 online Help.

If you find you are primarily doing document preparation 
tasks, consider using the Document Preparation 
toolbar for easy access to the tools you need. Show this 
toolbar by selecting it from the Apply Toolbar Set 
menu. See Applying a Toolbar Set on page 16.
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More to Explore: Trying Other Scanning Features
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3 Reading and 
Reading Settings

In this chapter, you’ll learn about:

• Reading in Kurzweil 3000 on page 52.

• Starting and Pausing Reading on page 52. 

• Changing Reading Settings on page 54.

You’ll also find Language Learning Options in More to Explore: 

Accommodating Language Learning on page 57.
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Reading in Kurzweil 3000
Reading in Kurzweil 3000
Kurzweil 3000 Reading is designed to improve comprehension, 
support independent reading and increase reading speed.

It provides multi-sensory support. You not only hear the words read 
out loud, but you also see each word highlighted. 

As with all Kurzweil 3000 functionality, there are many ways to tailor 
Reading to accommodate individual preferences and different 
learning abilities, requirements and goals. 

Starting and Pausing Reading 
In this exercise, you’ll open a document and start and pause reading.

What You’ll Need to Do This Exercise: The document entitled 
“Condor” from the “Sample Documents” folder.

1. Find and Open the document “Condor” from the “Sample 
Documents” folder.

2. Click where you want Kurzweil 3000 to begin reading.

3. Click the Read button.

What You Hear: Kurzweil 3000 begins reading out loud. 
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Chapter 3. Reading and Reading Settings
What You See: As Kurzweil 3000 reads, it uses two-color 
highlighting to help you follow along. 

Take a quick look at the Read button; it is now the Pause 
button. 

4. Click the Pause button to have Kurzweil 3000 stop 
reading.

5. Proceed to the next exercise to change the Reading Unit 
and Reading Speed. Or if you want to end here, Close the 
document.

By default, 
Kurzweil 3000 
highlights the 
entire sentence 
in one color and 
the spoken word 
in another color.
Kurzweil 3000 for Windows Tutorial 53



Changing Reading Settings
Changing Reading Settings
There are a number of Reading settings. The most frequently used 
ones are available as buttons on the Reading toolbar; others are in 
the Reading pane, accessible in the Options dialog from the Tools 
menu. 

In this exercise, you’ll change the Reading Speaker, Reading Unit 
and Reading Speed from the Reading toolbar.

What You’ll Need to Do This Exercise: The document entitled 
“Condor” from the “Sample Documents” folder.

1. Open the document “Condor” from the “Sample 
Documents” folder, if it isn’t already open.

2. Change the reading speaker. 

Click the Reading Speaker list arrow. 

Note: The list you see depends on your system’s speech 
engine.

Reading Speaker Reading Unit Reading Speed
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Chapter 3. Reading and Reading Settings
3. Change the reading unit:

Click the list arrow in the Reading Unit box. 

Select Paragraph.

This setting is useful for checking organization of thought.

4. Click the Read button to hear the selected reading unit. 

What You See: Kurzweil 3000 now highlights the paragraph 
and the spoken word.

5. Click the Pause button to stop reading.

When Reading 
Unit is set to 
Paragraph, 
Kurzweil 3000 
highlights the entire 
paragraph in one 
color and the 
spoken word in 
another color.
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Changing Reading Settings
6. Try changing the unit to Line or Phrase. When you’re 
done, return the unit to Sentence.

7. Change the reading speed by doing one of the following:

Click the Up or Down arrow in the WPM (Words Per 
Minute) box to increase or decrease the value.

Or click the value box and type the value you want. Try 
200.

8. Click the Read button to hear the new reading speed. 
When done, click Pause.

9. Now try 90, then click Read. What do you hear? When 
you’re done, click Pause and reset the WPM to 145.

10. Close the document without saving it.

Teaching and 
Learning Tips

If your goal is to improve reading and comprehension, 
begin with the Word reading unit.

If your goal is to increase reading speed, start with a 
comfortable speed or a target speed. With mastery, 
increase the speed.
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Chapter 3. Reading and Reading Settings
More to Explore: Accommodating Language 
Learning
Kurzweil 3000 supports many languages. To explore a document for 
language learning, Open “Josefina,” a Spanish document from the 
“Sample Documents” folder.

Open the Reading pane, accessible from the Tools Options menu, 
and select the desired language from the Language list (in this case, 
Spanish). Notice that the Speaker list changes; you can select an 
alternate speaker from this list. Click Apply and then OK.

Click Read to hear the document in the newly selected language.

Note: To scan a document that is in another language, use the OCR 
Language list in the Scanning pane.

Change Reading 
Language.

When you change the 
Language, the Speaker 
list also changes.
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More to Explore: Accommodating Language Learning
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4 Reference Tools 

In this chapter, you’ll learn about:

• The Syllables, Synonyms and Definition features in 
Reference Tools on page 60.

• Looking Up a Word on page 60. 

In addition, there are two exercises of interest: Creating a 

Word List Containing Definitions on page 64, in which you’ll learn 
how to create a study document by looking up and dragging 
and dropping definition text, and More to Explore: Using Online 

Encyclopedias on page 70, in which you can explore Kurzweil 
3000 Online Encyclopedia lookup.
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Reference Tools
Reference Tools 
Kurzweil 3000 provides a comprehensive set of reference tools, 
including dictionary, synonyms, syllables and spelling lookup, 
designed to help students improve vocabulary and increase word 
knowledge while reading.

Looking Up a Word
In this exercise, you’ll copy a document from the “Sample Documents” 
folder and use it to explore three lookup tools: Spelling, Syllables and 
Synonyms.

What You’ll Need to Do This Exercise: The document entitled 
“Horse’s Tale,” from the “Sample Documents” folder. It’s not necessary 
to save this document.

1. Open “Horse’s Tale” in the Sample Documents folder.

2. Click the Read button in the Main Toolbar.
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Chapter 4. Reference Tools
What You See and Hear: Kurzweil 3000 reading the 
document aloud and highlighting words as it reads.

3. Click the Pause button when you come across a word that 
you want to spell out loud, then double-click the word. Try 
“hostile.”

4. Click the Spell button in the Main toolbar.
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Looking Up a Word
What You See and Hear: The Word Spelling dialog and 
Kurzweil 3000 saying and spelling the word while displaying 
each letter.

5. Click Done to close the dialog.

6. Click the Syllables button.

What You See and Hear: The Syllables dialog and Kurzweil 
3000 saying the word and emphasizing the syllables.

Notice the Next button. It is an indication that this word has 
additional pronunciations. Click Next to give it a try.

7. Click Done to close the dialog.
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Chapter 4. Reference Tools
8. With the word still selected, click the Synonym button.

What You See: The Synonym window.

9. Click Read to hear the contents of the Synonym window. 
When you’re done, click the Close button in the Synonym 
window.

10. With the word still selected, click the Definition button.

What You See: The Definition window.

11. Click Read to hear the contents. When you’re done, click 
the Close button in the Definition window.

12. Close the document.
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Creating a Word List Containing Definitions
In this exercise, you’ll create a text document that will become a word 
list and display it side by side with another document. Next, you’ll work 
with the Definition lookup tool and drag and drop definition text into the 
new word list document.

What You’ll Need to Do This Exercise: The “Horse’s Tale” document 
from the “Sample Documents” folder.

1. Open the “Horse’s Tale” document from the “Sample 
Documents: folder.

2. Click the New File button in the Main toolbar.

What You See: The new text document covers the currently 
open document.

3. From the Window menu, choose Tile Vertically. (You 
could also choose Tile Horizontally if you are more 
comfortable with a horizontal display.)
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Chapter 4. Reference Tools
What You See: The documents side by side. Note that there 
may be slight differences between your documents and the 
ones in the Tutorial illustrations.

4. In the “Horse’s Tale” document, select a word. In this 
example, the Tutorial is using the word “hostile.” 

5. Click the Definition button.
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Creating a Word List Containing Definitions
What You See: The Definition window.

6. Click Read to hear its contents.

7. From the Window menu, choose Tile Vertically again to 
display the Definition window along with the “Horse’s 
Tale” document and the word list document.
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Chapter 4. Reference Tools
What You See: There should be three panes.

8. Now copy the definition text to the new document by 
selecting it and dragging and dropping it. 

Note: When you drag and drop text from the Definition 
window, it temporarily appears to be empty. 

Document Window Definition Window New document Window
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Creating a Word List Containing Definitions
What You See: The definition text “dropped” into the word list 
document.

9. If you want, find additional definitions and drag and drop 
them into the word list document.

10. When you’re done, click the Close button in the original 
document window to close it.

11. Save, rename and Close the word list document.

Definition Dragged into the New Document.
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Chapter 4. Reference Tools
Teaching and 
Learning Tips

Once you have created the word list document, you can 
distribute it to both your Kurzweil 3000 and non-
Kurzweil 3000 students as a pre-reading document.

Students who use Kurzweil 3000 can then have the 
program read the material, perhaps even repeatedly, to 
learn the content.

If you have students adept at using Kurzweil 3000, you 
can have them follow these instructions to create their 
own word lists from which they can study new 
vocabulary.

Another alternative to creating a quick word list is to use 
the Column Notes feature. Place the word in the first 
column, and the definition in the second column. Have 
students cover the definitions and give themselves a 
quiz and/or have students write sentences in the third 
column. 

You can create other study documents easily by using 
Notes, Color Highlighters, and the Extract 
Annotations feature. See the next two chapters.
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More to Explore: Using Online Encyclopedias
In addition to Definition, Syllable and Synonym lookup, Kurzweil 
3000 also provides an Online Reference Lookup feature, accessible 
from the Online menu. 

Using this feature, you can search through a set of online 
encyclopedias and reference sites, such as Columbia and Wikipedia, 
for the information you want.

Here are some helpful notes to keep in mind:

• To use this feature, your system must have Internet access.

• If you’ve worked with the other Kurzweil 3000 lookup tools, 
you know that there are two ways to do this: type a word or 
select a word. 

• When opting to look up a word you type, you don’t need to 
have a document open. 

• Additionally, when using the Online Reference Lookup 
feature, you can look up a word or phrase.

In the following exercise, you’ll select a word to look up and type a 
word to look up.

1. Open a document of your choice. To use the same document 
presented in this exercise, find and Open “Horse’s Tale” from the 
“Sample Documents” folder.
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Chapter 4. Reference Tools
2. Try one or both of the following methods:

Method A: Look up a selected word or phrase: With the 
“Horse’s Tale” document open, select Mark Twain in the “by” line, 
then select Online Reference Lookup from the Online menu. In 
the Online Reference Lookup dialog, select Encyclopedia 
Britannica Concise from the Search Site list. Click Search.

What You See: The search results. You can follow the links to 
other information and articles. 

You can Read the contents and/or Close the window.

Method B: Look up a typed word or phrase: Select Online 
Reference Lookup from the Online menu. This time in the 
Online Reference Lookup dialog, select Encyclopedia 
Britannica Concise from the Search Site list, then type the word 
or phrase you want (in this case, “king arthur”). Then click Search.
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More to Explore: Using Online Encyclopedias
What You See: The search results. You can follow the links to 
other information and articles.

3. Close any windows when you’re done.
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5 Notes and the 
Creation of a Study 
Document

In this chapter, you’ll learn about:

• Kurzweil 3000 Notes on page 75.

• Creating and Working with Sticky Notes and Text Notes on page 

77. 

• Creating and Working with Footnotes on page 81.

• Showing and Hiding Notes on page 84.

• Creating a Study Document by Extracting Notes on page 85. 
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You’ll also find out how to delete notes in More to Explore: 

Deleting a Note on page 89, and how to find notes in More to 

Explore: Finding Notes in a Document on page 89.
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Chapter 5. Notes and the Creation of a Study Document
Kurzweil 3000 Notes
There are many ways to take notes in Kurzweil 3000: the Color 
Highlighters work similarly to highlighter pens, and with half a dozen 
colors, they are a convenient way of noting different levels of 
information. Text and Sticky Notes allow you to embed annotations. 
Kurzweil 3000 can read highlighted text as well as contents in Text and 
Sticky Notes. Voice Notes enable you to record annotations. Bubble 
Notes are typically teacher-created, interactive instructional support. 
In addition there are Footnotes and Text Circle tools.

If you are a student, you can use these study skills tools to help you 
remember key points, to create study notes and questions, and/or to 
insert footnotes in research papers. Knowing how to use Text Notes is 
also important for taking tests using Kurzweil 3000. Bubble Notes can 
enable you to respond to your instructor’s prompts and/or questions.

If you are a teacher, Kurzweil 3000 Notes can help you embed 
reminders, and additional information in class work as well as in test 
material. Bubble Notes are especially useful as instructional support, 
allowing you to add prompts and questions to ensure that students 
stay on task and/or are comprehending the material.

In this chapter, you’ll work with Sticky, Text and Footnotes. For 
information on Voice Notes, see Kurzweil 3000 online Help. For 
information and exercises on:

• Color Highlighters, see Highlighting Text in a Document on page 
93. 

• Text Circle tools, see Using the Text Circle Tool for Multiple Choice 
on page 200.
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Kurzweil 3000 Notes
To show the Study Skills toolbar: 
To do the exercises in this chapter, you must have the Study Skills 
toolbar showing.

Click the green Toggle along the left edge of the Kurzweil 3000 toolbar 
area to show or hide the Study Skills toolbar. You can also use 
CTRL+SHIFT+F11.
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Chapter 5. Notes and the Creation of a Study Document
Creating and Working with Sticky Notes and 
Text Notes
In this exercise, you’ll copy a document from the “Sample Documents” 
folder and work with Sticky Notes and Text Notes.

Note: Sticky and Text Notes are available only in image documents.

Sticky Notes are helpful as reminders and prompts and are useful for 
embedding instructions and questions. 

Text Notes are useful not only for adding study notes to documents, 
but they are also the tool you use to fill out forms, worksheets, and 
tests in Kurzweil 3000.

It’s possible to “extract” Sticky Notes and Text Notes into a new text 
document, which you can then use as a study document. See Creating 
a Study Document by Extracting Notes on page 85.

What You’ll Need to Do This Exercise: The document entitled 
“Horse’s Tale.” 

1. Find “Horse’s Tale” in the “Sample Documents” folder. 
Copy it, rename it “my Horse’s Tale,” and Open it.
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Creating and Working with Sticky Notes and Text Notes
2. Create a Sticky Note:

Click the Sticky Note button in the Study Skills toolbar.

Because Sticky Notes cover the images below, you may 
want to place them in empty spaces. Margins are ideal 
spots. 

Click in the margin where you want to place the note.

Type your note. In this case, “Who is telling the story?”

To create new text lines in the Sticky Note, press the Enter 
key for a hard return. 

When you are done, click outside the note.

What You See: The Sticky Note in the margin.

3. Resize the Sticky Note:

Point to the left or right border to show the size arrow.

Move the mouse side to side until the note is the desired 
size.
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Chapter 5. Notes and the Creation of a Study Document
What You See: The resized Sticky Note.

4. Move the Sticky Note:

Hover the pointer on the top or bottom border of the note 
to show the four-arrowed compass.

Drag and drop the note to a new location.

5. Create two more Sticky Notes in the same way, if you want 
additional practice. 

6. Create a Text Note:

Click the Text Note button in the Study Skills toolbar.

Click where you want to place the note.

In the empty Text Note, type the desired text. If you want 
to follow our example, type: “Use three words to describe 
the main character.”

To create new text lines, use the Enter key for line breaks.

When you are done typing, click outside the note.
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Creating and Working with Sticky Notes and Text Notes
What You See: Notice that the Text Note is transparent.

7. Edit a note:

Click inside the desired note. Use text editing functions to 
edit it.

When you’re done, exit the note by clicking outside it.

8. This is a good time to Save the document.

9. To read a Sticky Note or Text Note: Click inside it, then click 
the Read button. 

10. When you’re done, click outside the note.

11. Continue to the next exercise. If you need to end here, click 
the Close button. 
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Chapter 5. Notes and the Creation of a Study Document
Creating and Working with Footnotes
Footnotes work in either image or text documents. Each footnote has 
a numbered anchor and is associated with the text in which you place 
it. Footnotes are ideal for research papers and study documents.

What You’ll Need for This Exercise: The document entitled “my 
Horse’s Tale” from the previous exercise. 

1. Open “my Horse’s Tale.” 

If you did not do the previous exercise, find “Horse’s Tale” 
in the “Sample Documents” folder. Copy it, rename it “my 
Horse’s Tale,” then Open it.

2. Click on the word to which you want to attach the Footnote; 
“Buffalo Bill,” in the first paragraph is a good spot.

3. Click the Footnote button in the Study Skills toolbar.
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Creating and Working with Footnotes
What You See: The Footnote number in red, “anchored” next 
to the word, and the Footnote window in the bottom half of the 
Kurzweil 3000 window.

4. Type inside the Footnote window. 

5. To read a Footnote:

If your cursor is already in an open Footnote, click Read. 

If a Footnote is closed, double-click on the Footnote 
anchor number to open the Footnote window, then click 
Read. Kurzweil 3000 automatically reads the contents by 
default.
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Chapter 5. Notes and the Creation of a Study Document
6. When you’re done with a Footnote, close it by doing one of 
the following:

• Click the Footnote Close button in the Study Skills 
toolbar.

• Click the Close X box in the Footnote window.

• Press the ESC key.

• Or double-click the anchor of the open Footnote. This 
is a handy method for opening any Footnote.

7. This is a good time to Save the document.

8. Continue to the next exercise. If you need to end here, click 
the Close button. 
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Showing and Hiding Notes
You can show or hide Kurzweil 3000 Notes. Hiding annotations does 
not remove them from the document, but provides a clear view of the 
document.

What You’ll Need to Do This Exercise: A few Sticky Notes, Text 
Notes and/or Footnotes created in “my Horse’s Tale” document, and 
the document open. See the previous exercises on creating Notes. 

1. Hide Notes:

From the View menu, click Annotations.

By default, all notes are checked (that is, visible).

Click the annotations you’d like to hide. In this case, click 
the Show Notes check box to uncheck it.

2. Take a look at the document. The Sticky Note, Text Note 
and Footnote anchor are no longer visible.

3. Click Show Notes again to make notes visible again.

4. If you plan on continuing to the next exercise, Save the 
document. You can also Close and Save the document for 
another session.
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Creating a Study Document by Extracting 
Notes
Creating a variety of study tools including study guides, summaries, 
and simple word lists is very easy to do with the Extract feature.

What You’ll Need to Do This Exercise: A few Sticky Notes, Text 
Notes and/or Footnotes created in “my Horse’s Tale” document as you 
had done in the previous exercise and the document open.  

1. From the File menu, choose Extract Annotations.
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Creating a Study Document by Extracting Notes
What You See: The Extract Annotations dialog.

2. In the Extract Annotations dialog, check the 
Annotations box, uncheck the Bookmarks and the 
Highlights boxes, then click OK.
86



Chapter 5. Notes and the Creation of a Study Document
What You See: Kurzweil 3000 creates and opens a new text 
document with all the notes you had created. Your document 
may not have the same content as the one below:

Kurzweil 3000 presents the extracted notes by page and in 
Footnotes, Text Notes, and then Sticky Notes order.

Note: You can edit extracted documents using text editing 
functions. 

3. Save and Close the extracted document. 
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Teaching and 
Learning Tips

Once you have the extracted document, you can edit it 
to contain just one type of information, such as 
questions or instructions. You can then print the 
document and distribute it to all students and have a 
Kurzweil 3000 version for students who will be using the 
program to work with the document.

Encourage students to take notes using Kurzweil 3000 
notes, extract the notes, and read and re-read the 
material to learn it. 
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More to Explore: Deleting a Note
To do this exercise, you can use the “my Horse’s Tale” document 
containing notes. 

More to Explore: Finding Notes in a Document
To do this exercise, use “my Horse’s Tale” document containing notes. 

1. Click a note you want to delete.

2. Click the Delete note button in the Study Skills toolbar. 

3. In the message dialog, click Yes to confirm.

1. Click at the beginning of the document.

2. From the Edit Find submenu, select Object to open the 
Find Object dialog.

3. Select Note, then click Find.
Kurzweil 3000 for Windows Tutorial 89



More to Explore: Finding Notes in a Document
90



6 Color Highlighters 
as Study Tools

In this chapter, you’ll learn about:

• Kurzweil 3000 Color Highlighters on page 92.

• Highlighting Text in a Document on page 93.

• Using Reading by Highlight to Study on page 95.

• Creating a Summary Document in an Outline Style on page 96. 

In More to Explore: Erasing Highlights on page 98, find out how 
to erase highlights. In More to Explore: Labeling Highlight Colors 
on page 99, learn how labeling highlight colors helps in 
organizing information.
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Kurzweil 3000 Color Highlighters
Color Highlighters are another type of Kurzweil 3000 study skills tool. 
The benefits of Kurzweil 3000 electronic highlighting include the ability 
to:

• Associate different concepts with different colors. For 
example, you can use yellow for main ideas, green for details, 
blue for vocabulary, and so on. 

• Hear only the material you highlighted.

• Extract highlighted material and create new documents that 
can serve as study aids, such as pretest questions, outlines 
and summaries.

Highlighters work in both image and text documents, and can be used 
to select answers on Multiple Choice tests.

To show the Study Skills toolbar: 
To do the exercises in this chapter, you must have the Study Skills 
toolbar showing.

Click the green Toggle along the left edge of the Kurzweil 3000 toolbar 
area to show or hide the Study Skills toolbar. You can also use 
CTRL+SHIFT+F11.
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Highlighting Text in a Document
Kurzweil 3000 provides multiple highlighting colors, making it easy to 
organize and categorize information while reading or studying.

In this exercise, you’ll use yellow for main ideas and green for details.

What You’ll Need to Do This Exercise: The document entitled “my 
Horse’s Tale.” 

1. Open the “my Horse’s Tale” document. If you don’t have it, 
you can find “Horse’s Tale” in the “Sample Documents” 
folder. Copy it, rename it “my Horse’s Tale,” then Open it.

2. Highlight a main idea by using the yellow highlighter:

In the document, click the Yellow Highlighter button in the 
Study Skills toolbar.

Click at the beginning of the main text you want, then drag 
the Highlighter cursor to the end of the phrase to select it. 
In this case, try, “Buffalo Bill’s.”

3. Highlight details for that main idea by using the green 
highlighter:

Click the Green Highlighter button.

Select details: In this case, try as many of the following as 
you want: “two hundred pounds,” “over six feet,” “young,” 
“graceful,” “quick,” “handsome” and “braver.”
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Highlighting Text in a Document
4. Highlight another main idea and its associated details.

Try: “horse” for main idea in yellow highlighter. In green 
highlighter select: “not large,” “good family,” “best-
educated,” and “best-mannered.”

5. To stop highlighting, click the Highlighter button you were 
just using. 

What You See: Some text as main ideas highlighted in yellow 
and other text as details highlighted in green. 

6. This is a good time to Save the document.

7. Continue to the next exercise. If you need to end at this 
time, click Close. 

Main ideas 
appear in 
yellow 
highlight.

Supporting 
details 
appear in 
green 
highlight.
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Using Reading by Highlight to Study
This feature is particularly useful for reviewing a document or studying 
for a test.

In this exercise, you’ll read the highlights you created in the previous 
exercise.

What You’ll Need to Do This Exercise: The document entitled “my 
Horse’s Tale,” from the previous exercise.

1. Open “my Horse’s Tale” from the previous exercise. It 
should have text that has been highlighted. 

2. Click the Reading Unit list arrow in the Reading toolbar, 
and select Highlight to hear only the material you 
highlighted.

3. Click anywhere before the first highlighted text. 

4. Use the Read/Pause button to read and stop reading.

What You Hear: Kurzweil 3000 reads the highlighted text.

5. When you’re done, reset the Reading Unit to Sentence. 

6. Continue to the next exercise. 
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Creating a Summary Document in an Outline 
Style
You’ve already experienced how easy it is to create study aids. In this 
exercise and the next, you’ll create a summary document. 

What You’ll Need to Do This Exercise: The document entitled “my 
Horse’s Tale” from the previous exercise. 

1. Open “my Horse’s Tale” from the previous exercise. This 
document should contain multi-color highlights to denote 
multi-level information.

2. From the File menu, choose Extract Annotations.
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What You See: The Extract Annotations dialog.

3. Check the Highlights box; uncheck the Annotations and 
Bookmarks boxes.

4. Click through the Outline Style box until you see the style 
you want. Roman Numerals is the widely used style.

The Indents and Prefixes change for each style. 

Note: Indents and Prefixes can be customized. Details are 
in online Help.

5. Click OK.
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More to Explore: Erasing Highlights

What You See: A new document with the material you 
highlighted. 

You can edit the new extracted document using text editing 
functions. In the example above, for instance, you could delete 
the apostrophe and the letter “s” after the word “Bill” and the 
other unnecessary punctuation marks to finish the outline.

6. Close and Save the newly created document:

Click Close. 

In the Close dialog, click Yes to save it.

In the Save As dialog that appears, type the new name 
“my summary” or “my outline” in the File Name box.

Click Save.

7. Close “my Horse’s Tale” unless you want to do a More to 
Explore exercise.

1. Click the Erase button in the Study Skills toolbar.

2. Drag the cursor over the desired highlighted text.
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More to Explore: Labeling Highlight Colors
Since you can use the different color highlighters as a way to organize 
information and ideas, it may be helpful to label each color so that you 
and your students can remember which color to use for different types 
of information. Doing this also promotes consistency and provides 
students with additional experience in organizing information and 
thoughts. 

A possible labeling scheme might be “Main Idea” for yellow 
highlighting, “Detail” for green, and so on.

1. To label highlighters, use the Highlighters pane, accessible from 
the Tools Options menu.

2. In the Highlighters Options pane, click in the desired Caption 
text box, type the desired name, then click Apply and OK.

In the following example, the captions are set to “Main Idea” and 
“Details,” etc.
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3. To see a label, point your cursor at the desired color highlighter 
button. The label appears in the button’s Tool Tip, as in the 
example below. 

Note: Highlight label changes also appear in the following places: 

• In the Tools Highlight menu.

• In the Extract Annotations dialog.

• In the Print Highlighted Text dialog.
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7 Bubble Notes as 
Instructional 
Support

In this chapter, you’ll learn about:

• Bubble Notes on page 103.

• Opening and Hearing a Bubble Note on page 105.

• Selecting Answers for Check Box Questions on page 108.

• Matching Answers on page 111.

• Adding an Instructional Note on page 114.

In More to Explore: Setting Up Uninterrupted Reading on page 117, 
find out how to not have Bubble Notes open automatically 
for uninterrupted reading.

There are a couple of additional More to Explore sections: 
More to Explore: Editing a Bubble Note on page 117, More to 
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Explore: Deleting a Bubble Note on page 118, More to Explore: 

Moving a Bubble Note on page 118.

In the first several topics, you’ll learn about Bubble Notes 
from the perspective of a student/end user. You can use the 
information to train students to use Bubble Notes, or, if your 
students are capable, you can have them go through the 
exercises by themselves. 

The last several topics in the chapter are for teachers or 
someone who will be embedding and authoring instructional 
notes.
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Bubble Notes
Bubble Notes are either balloon- or cloud-shaped notes. By default, 
they open as Kurzweil 3000 encounters them in Continuous Reading 
mode.

Bubble Notes are anchored to words. In an image document, the 
anchor is a question mark in a purple box.

In a text document, the word in which the Bubble Note is anchored 
appears in purple and is underlined.

They are typically created by a teacher to give students additional 
instructions or quick questions to assess comprehension. Depending 
on the options selected for a Bubble Note, it may:

• Either open or not open.

• Read or not read when opened.

• Be read before or after a unit, or after a word is read.

• Spell a keyword.

• Contain questions in a number of different formats, including 
True or False, Multiple Choice, or Text Answer.

In this chapter, you will work with existing Bubble Notes and create a 
new one.
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Bubble Notes
Before Doing the Exercises in This Chapter
Before working with Bubble Notes, ensure the following:

• Reading Mode is set to Continuous.

• Reading Unit is set to Phrase, Line, Sentence or 
Paragraph. 

• Show Notes, on the View Annotations menu is enabled.
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Opening and Hearing a Bubble Note
If the author of the Bubble Notes kept the default settings, as soon as 
you reach a Bubble Note anchor while reading continuously, Kurzweil 
3000 automatically opens the Note and begins reading.

If Kurzweil 3000 is not reading, you can double-click on a Bubble Note 
anchor to open and hear it.

In this exercise, you’ll do both.

What You’ll Need to Do This Exercise: The “Horse’s Tale Bubble 
Notes” document in the “Sample Documents” folder.

1. Open “Horse’s Tale Bubble Notes.” From the File menu, 
choose Save As and rename the file to “my Horse’s Tale 
Bubble Notes.”

2. Click at the beginning of the document. 

3. Click the Read button to begin reading.

What You See and Hear: The first Bubble Note in the 
document and Kurzweil 3000 reading its contents.

Note: As usual, Kurzweil 3000 highlights words and reading 
units as it reads.

4. When you’re done, click OK in the Bubble Note to close it.
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Opening and Hearing a Bubble Note
5. Continue to read the document. The next Bubble Note will 
open when you encounter it. 

What You See and Hear: The second Bubble Note in the 
document and Kurzweil 3000 reading its contents. 

6. Because you can respond to this Bubble Note, it includes 
a Cancel button. Click Cancel for now to close the note.

7. Pause reading and go to page 2.

8. Manually open a Bubble Note by double-clicking its 
anchor. In this case, click the anchor near the word “bugle-
calls” to open its note.
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Note: You can stop Kurzweil 3000 from reading the contents of any 
Bubble Note by clicking on the main text of the Bubble Note or by 
pressing the F3 key.

What You See and Hear: The open Bubble Note and Kurzweil 
3000 reading the contents. 

9. Because you can respond to this Bubble Note, it includes 
a Cancel button. Click Cancel for now to close the note.

10. Close the document if you want to end here. Or continue 
to the next exercise to learn how to use check boxes in 
Bubble Note questions. 
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Selecting Answers for Check Box Questions
The most typical Bubble Notes are instructional ones that give you 
directions and prompts, like the one you worked with in the previous 
exercise. However, you may encounter questions in some Bubble 
Notes. 

In this exercise, you’ll answer a check box-type Multiple Choice 
question in a Bubble Note. Remember that you can use the same 
steps to respond to two other types of Multiple Choice questions: True 
or False and radio buttons. The only difference is for True or False and 
radio buttons, there is only one correct answer for you to select. In 
check box-type questions, you can select all items that apply.

What You’ll Need to Do This Exercise: The “my Horse’s Tale Bubble 
Notes” document from the previous exercise.

1. Open “my Horse’s Tale Bubble Notes” if it isn’t already 
open. 

If you do not have this document, open “Horse’s Tale 
Bubble Notes.” From the File menu, choose Save As and 
rename the file to “my Horse’s Tale Bubble Notes.”

2. Scroll through the document and find the word “myself” at 
the end of the first paragraph. 

What You See: A Bubble Note anchor attached to the word.
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3. Double-click the anchor to open its Bubble Note.

What You See and Hear: The open Bubble Note containing a 
check box-style Multiple Choice question, and Kurzweil 3000 
reading its contents. 

Note: Some letters are underlined, indicating that you can 
press the ALT key plus the letter key to select and deselect 
that answer. 

4. To select an answer(s), you can click on the desired check 
box(es), or you can press ALT plus the underlined letter in 
the answer you want. For instance, ALT+M would select 
Slim.
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Selecting Answers for Check Box Questions
5. Then do one of the following:

• Click OK if you want to save the answer and close the 
note.

• Click Cancel if you want to close the Bubble Note 
without answering the question.

6. Save the document. This is recommended as it allows the 
student and/or teacher to review progress.

Close the document if you are ending your Tutorial 
session, or continue to the next exercise to learn how to 
respond to a Matching question. 
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Matching Answers 
You may encounter questions in some Bubble Notes that require you 
to match answers, which is what you’ll do in this exercise. 

What You’ll Need to Do This Exercise: The “my Horse’s Tale Bubble 
Notes” document.

1. Open “my Horse’s Tale Bubble Notes” if it isn’t already 
open. 

If you do not have this document, open “Horse’s Tale 
Bubble Notes.” From the File menu, choose Save As and 
rename the file to “my Horse’s Tale Bubble Notes.”

2. Go to page 2. Find the word, “speech,” and the Bubble 
Note anchored to it.

3. Double-click the anchor to open the Bubble Note.

What You See and Hear: The open Bubble Note, containing 
a question and a text box, and Kurzweil 3000 reading its 
contents. 
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Matching Answers
Note: Some letters are underlined, indicating that you can 
press ALT plus that letter key to select and deselect that 
answer.

4. Match answer(s): From the left-hand column, click on the 
dash line that follows the desired item, then drag the line to 
an answer in the right-hand column. 

Or you can use keyboard keys: In this case, press 
ALT+S to select “springy” from the left-hand column, then 
press ALT+F to select “flexible” from the right-hand column 
to make a match.

5. Repeat step 4 to make other matches. 

Note: Don’t worry if you do not know the answers. You can 
make random matches; this exercise is for learning how to 
use Kurzweil 3000.
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6. When you are done, do one of the following:

• Click OK if you want to save the answer and close the 
Note.

• Click Cancel if you want to close the Bubble Note 
without saving the answer.

7. Save the document. This is recommended as it allows the 
student and/or teacher to review the student’s answers.

Close the document if you are ending your Tutorial 
session. 
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Adding an Instructional Note
In this exercise, you’ll create a Bubble Note containing instructions.

1. Find and Open the “Horse’s Tale Bubble Notes” document 
from the "Sample Documents" folder, if it’s not already 
open. From the File menu, choose Save As and rename 
the file to “my Horse’s Tale Bubble Notes.”

2. Click where you want to place the Bubble Note anchor in 
the document.

3. From the Tools menu, select Note, then choose Add 
Bubble Note.

What You See: The Bubble Note dialog.
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4. Select the Bubble Note Appearance you want: Balloon or 
Cloud. In this case, select Cloud.

5. Decide how and when you want the note to open. Since 
this pre-reading note should be read at the beginning of the 
text in which the Bubble Note is anchored, click Open 
before unit is read.

6. Type the content for the note. Click in the Content text box. 
For this exercise, type “As you read, think about what the 
narrator is like.”

What You See: Content in the note.

7. Click Preview to preview the note as the reader would 
encounter it in the document.
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What You See and Hear: The Preview version of the note at 
the bottom of the Bubble Note dialog, and Kurzweil 3000 
reading the contents.

8. Exit Preview mode by clicking OK inside the Preview 
version.

9. Click OK in the dialog to close it.

What You See: In the document, the Bubble Note anchor (a 
rectangle with a question mark in it) at the cursor position.

Note: If you are using a text document, the anchor will be a 
question mark and the word to which it is attached will be 
underlined as in the example below.

10. Close the document. If you want, you can also Save it.
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More to Explore: Setting Up Uninterrupted 
Reading
By default, Kurzweil 3000 opens and reads a Bubble Note when it 
encounters an anchor. You may want to provide students with 
uninterrupted reading for some sessions and with Bubble Notes 
opening for other sessions. You can direct Kurzweil 3000 to open and 
read some or none of the Bubble Notes.

In .KES image documents you can opt to not show and therefore not 
open and read the notes, disable Show Notes from the View 
Annotations menu. This option hides the Bubble Note anchors. 

To not open and read a specific Bubble Note, click the desired note 
anchor. From the Tools Note menu, choose Edit Bubble Note. In the 
Bubble Note dialog, deselect the Open while reading option. 
Deselecting this option displays the Bubble Note anchors in the 
document but does not open the notes.

More to Explore: Editing a Bubble Note
To edit existing Bubble Notes, select the anchor, then use Edit Bubble 
Note to make any changes you want. Edits can include changes to 
options as well as changes to content.
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More to Explore: Deleting a Bubble Note
To delete a Bubble Note, select its anchor, then choose Delete Note 
from the Tools Note menu.

More to Explore: Moving a Bubble Note
To move a Bubble Note, click its anchor and drag it to a new location.
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8 Column Notes

In this chapter, you’ll learn about:

• Kurzweil 3000 Column Notes on page 120. 

• Using Color Highlighters to Take Notes on page 121.

• Extracting Highlights to Column Notes and Saving the Column 

Notes File on page 123. 

• Taking Notes Across Documents on page 127.

• Using Column Notes to Study on page 129.

In addition, you’ll find:

• More to Explore: Appending New Notes to an Existing Column 

Notes File on page 131.

• More to Explore: Editing Column Headers on page 131.

• More to Explore: Resizing the Column Notes Window and 

Columns on page 132.
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Kurzweil 3000 Column Notes
Being able to take notes is an important skill. With Kurzweil 3000 
Column Notes, you can employ two- and three-column note-taking 
methods such as the universally accepted Cornell Notes strategy. This 
feature provides the support for collecting information while you read 
and do research. Once you save a Column Notes file, you can use it 
across documents, across sessions or across chapters of any book. 
It’s also an invaluable tool for studying and taking class and lecture 
notes on the go.

Additionally, the Column Notes feature serves as the critical link 
between Reading and Writing. By using color highlighters, you can 
take notes as you read, pull them into Column Notes, and then with 
one command, extract the notes into the Outline in the Kurzweil 3000 
Writing Path, an integrated set of features that guides you through the 
writing process. For more information about the Writing Path, see 
online Help and/or The Writing Path on page 133.

You can find Column Notes on the Tools menu or as a button on the 

Study Skills toolbar.  

There are multiple ways to bring text into Column Notes, you can type 
directly into the note cells, Copy and Paste, or extract highlighted text 
if you have taken notes with the Color Highlighter pens. This last 
method is presented in this chapter.
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Using Color Highlighters to Take Notes
If you have completed an earlier chapter on highlighting and extracting 
notes, you are already familiar with how handy the Color Highlighters 
are for taking notes, especially for multi-level information. 

What You’ll Need to Do This Exercise: 
• “A Place Called Heartbreak” (Heartbreak) from the “Sample 

Documents” folder. 

• The Study Skills toolbar showing. (Click the Green brick icon 
in the toolbar.)

1. Open the Heartbreak document, and Save As “Heartbreak 
Highlights.”

2. In “Heartbreak Highlights,” go to page 9.

3. Click the Yellow Highlighter button. In the document, 
select “the Cherry family” as the main idea.

4. Click the Green Highlighter button, select the following as 
details:

“The head of the Cherry family always had at least two 
jobs,”

“They were trying to improve the whole family's chances 
for success.”

5. Add another main idea. Click the Yellow Highlighter 
button again. Select “All the children were expected to 
pitch in.”
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6. Add details. Click the Green highlighter. Find and select 
the following:

“You did what you were supposed to do, you did it well, and 
you didn't complain.”

“expected to study”

“help with the chores.”

7. Save the document, and continue to the next exercise to 
extract the highlights into Column Notes.

You may have to close the original Heartbreak document; 
Do Not save that file.
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Extracting Highlights to Column Notes and 
Saving the Column Notes File
This next exercise should convince you that taking notes with the 
Color Highlighter pens as you read is both expedient and convenient, 
especially as you continue through the secondary school grades and 
progress on to higher-level academic material and assignments.

With a single command, Extract Highlights to Column Notes, Kurzweil 
3000 enables you to collect your notes into a versatile Column Notes 
file.

In addition to extracting highlights to Column Notes, this exercise 
includes some editing in the Column Notes window, and saving the 
Column Notes file.

What You’ll Need to Do This Exercise: 
• “Heartbreak Highlights” document from the previous exercise 

open. It should contain highlighted text.

• The Study Skills toolbar, including the Column Notes 
button.

1. In the open “Heartbreak Highlights” document, go to the 
File menu and choose Extract Highlights to Column 
Notes.
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Extracting Highlights to Column Notes and Saving the Column Notes File
What You See: The Extract to Column Notes dialog. 

By default yellow highlights will be placed in the first column, 
and green highlights in the second column.

2. Click OK.

3. In the Open Column Notes dialog that appears, select 
Using a Blank Note File, if it is not selected, then click OK.
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What You See: The Column Notes window opens below the 
document window.

The main idea text that was highlighted in yellow is in the first 
column while the details that were highlighted in green are in 
the second column and associated with their respective main 
ideas.

4. Try some editing in the Column Notes window. The third 
column is the ideal place to add elaborations and source 
information.

Click in a cell in the third column. Type:

“Heartbreak. Chapter 2, page 9.”

Copy and Paste the text you just typed into the next cell in 
the same column. (You may have to use the scroll bar in 
the Column Notes window.)

If you make a mistake, press CTRL+Z to Undo.

Word Prediction and Spell Check are also available.
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5. Click inside the Column Notes window, then click the 
Save button.

Kurzweil 3000 saves Column Notes files in XML format in 
the Notes folder.

6. In the Save As dialog, name the Column Notes file: “My 
Column Notes,” then click OK.

This Column Notes file is ready for another chapter, 
document or session.

7. Simultaneously close the document and Column Notes 
windows by clicking the document window Close button.

You may be asked if you want to save the changes in the 
document. You may do so although it is not necessary for 
subsequent exercises.

8. Continue to the next exercise to learn how to use the newly 
saved Column Notes file in another document.
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Taking Notes Across Documents 
One of the benefits of Column Notes is that you can use a set of notes 
in a single file across multiple documents or chapters. You can add or 
append to an existing file.

What You’ll Need to Do This Exercise: 
• An existing Column Notes file, “My Column Notes,” created in 

the previous exercise.

• “Heartbreak Highlights” from an earlier exercise, or you could 
open any document you want.

• Study Skills toolbar showing.

1. Open the “Heartbreak Highlights” file, then go to page 18, 
chapter 3.

2. Click the Column Notes button.

In the Open Column Notes dialog, select Using an 
Existing Note File, then click OK.

3. In the Open dialog, select “My Column Notes” from the list, 
then click Open.

What You See: The Column Notes window opens at the 
bottom of the document window. Notes from the previous 
session are in the columns.

4. Click in the Column Notes window and use the scroll bar 
to scroll to the next empty row.
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Taking Notes Across Documents
5. Click in the “Heartbreak Highlights” document window to 
make it the active window, then select and Copy any text. 
(You may have to scroll.)

6. Click in the Column Notes window in the next empty first 
column cell and Paste the text.

7. Repeat the previous two steps; this time paste into the next 
cell in the second column. 

8. Click the Save button. 

This Column Notes file is ready for another chapter, 
document or session. More importantly, it is ready for you 
to bring into the writing stage. See Creating an Outline from 
Column Notes on page 151.

9. Continue to the next exercise to learn how to use the 
Column Notes file to study.
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Using Column Notes to Study
Like the Cornell Note-Taking system, the multiple columns and show-
hide column commands in Column Notes encourage and support 
studying efforts.

What You’ll Need to Do This Exercise: 
• An existing Column Notes file, “My Column Notes,” created in 

an earlier exercise.

• Study Skills toolbar showing.

1. Click the Column Notes button.

In the Open Column Notes dialog, select Using an 
Existing Note File, then click OK.

2. In the Open dialog, select “My Column Notes” from the list, 
then click Open.

What You See: The Column Notes window opens at the 
bottom of the document window. Notes from the previous 
session are in the columns.

3. Study the main ideas and their details.

4. Give yourself a quick quiz.

Click inside the Column Notes window to ensure it is the 
active window.

Click the right mouse button to open the shortcut menu, 
then choose Cover 2nd Column.
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What You See: The second column covered.

5. Recall the details.

When you are done, open the shortcut menu again and 
choose Show 2nd Column. How well did you remember 
the details?

6. Another way to study is to write a brief summary: for any of 
the main ideas, click its right column cell and type your 
summary.

7. The third column can also be hidden, enabling you to recall 
your summary sentence:

From the shortcut menu, choose Hide 3rd Column.

8. Lastly, you can Print the Column Notes file, with or without 
the second and/or the third column. Print is on the shortcut 
menu.

9. Click the document Close button. Click Yes to save the 
Notes file. In the Notes Save As dialog, click OK. 

In the document message, click Yes to save the document.
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More to Explore: Appending New Notes to an 
Existing Column Notes File
In an earlier exercise in this chapter you added notes to a Column 
Notes file. To append notes: 

1. Open the document from which you want to take notes.

2. Click the Column Notes button and specify Using a Blank File in 
the Open Column Notes dialog.

3. Take your notes.

4. Click inside the Column Notes window, then click Save.

5. In the Save As dialog, find and select the existing Column Notes 
file to which you want to append the new notes. Click OK.

6. In the Save Options dialog, click Append.

7. Click the document Close button to close both windows.

More to Explore: Editing Column Headers
Suppose you want to use Column Notes for vocabulary building; you 
could rename the column headers. With the pointer anywhere in the 
header, open the right mouse button menu and choose Edit Column 
Headers. Enter the new names and click OK.
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More to Explore: Resizing the Column Notes 
Window and Columns
To Resize: Do:

a column Place the pointer in the Column Notes 
window header area (gray area) at the lined 
border until a left-right arrow appears.

Drag the arrow left or right to the desired 
column width.

Column Notes window Place the pointer at the top border of the 
window (blue area) until a up-down arrow 
appears.

Drag the arrow up or down to the desired 
window height.
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9 The Writing Path

In this chapter, you’ll learn about:

• Kurzweil 3000 Writing Path on page 134.

• Creating a Brainstorm Diagram on page 135.

• Creating an Outline on page 143.

• Switching Between Brainstorm and Outline on page 147.

• Creating an Outline from Column Notes on page 151.

• Creating a Draft from Outline on page 153.

• Using the Review Check List on page 157.

In addition, you’ll find More to Explore: Adding Brainstorm Notes 
on page 142. 
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Kurzweil 3000 Writing Path
The Kurzweil 3000 Writing Path, an integrated set of features based 
on the writing process taught by educators, takes you through 
brainstorming, outlining, drafting and reviewing. 

After doing your reading and gathering your information, you can get 
all your ideas out and organize your thoughts into a writing plan by 
using either Brainstorm or Outline.

Brainstorm is a graphic organizer that lets you create thoughts, and 
link and organize those thoughts in a diagram format. 

With the Outline feature you can jot down your ideas in text format, 
organize them, and present them in a variety of outline styles. 

Brainstorm and Outline share information but present it in two different 
views. So whatever changes you make in one, will show up in the 
other.

After you have your writing plan, and you're ready to write, you can 
use Draft from Outline (full-screen view) or the Split Screen view in 
which the window is split into two panes, the left one for the outline 
display and the right pane for writing and editing.

Remember that the actual writing process is a cycle, you write, then 
review and re-write. At any time, you can display a Review list to help 
you track reviewing tasks, such as checking for punctuation, 
capitalization, and spelling.

The Writing Path features are available on the Write menu or the 

Writing toolbar (look for a four-button set  from left to right: 
Brainstorm, Outline, Draft and Split Screen view).
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Creating a Brainstorm Diagram
Brainstorm is a graphic organizer and is one of the two ways you can 
formulate your writing plan. The Brainstorm diagram is made up of:

• Shapes in which you enter your Thoughts.

• Links for indicating the relationships among Thoughts and the 
organization of your ideas.

It’s important to remember that because Brainstorm, Outline and Draft 
are part of the Kurzweil 3000 Writing Path, they share the same 
information that can be viewed in different modes. Changes you make 
in one are reflected in the other.

This makes it possible to start your writing plan in Outline then switch 
to Brainstorm view. You might even find it useful to switch back and 
forth between Brainstorm and Outline as you create your writing plan. 
Copying and pasting is another way to bring content into Brainstorm.

This exercise will take you through the following:

• Creating Brainstorm thoughts.

• Changing shape properties.

• Reorganizing thoughts.

• Linking thoughts.
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Creating a Brainstorm Diagram
What You’ll Need to Do This Exercise: Writing toolbar showing.  

1. With no documents open, click the Brainstorm button in 
the Writing toolbar.

What You See: The default Brainstorm window with the Main 
Idea thought and the Brainstorm tools palette.

2. Select the default shape. Click again to open the text box.

Select the text and type: “vacation” to replace the original 
text.

3. When brainstorming, you may want to get your thoughts 
out quickly.

To do this, click the Quick Takes button (first button in the 
upper-left corner) in the palette.

The thunderbolt marker indicates that the Quick Takes 
mode is enabled.
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4. To get the next level of thoughts out there:

Type: "hiking” and press ENTER.

Type: "camp” and press ENTER.

Type: "farm” and press ENTER.

While inside the thoughts, you can use familiar editing 
functions.

What You See: First level of thoughts in Brainstorm. The lines 
with arrow heads represent links. The beginning of the line is 
attached to the originating thought, also known as the “parent” 
and the arrow is pointing to the target thought, also known as 
the “child.”

5. To go down another level, click twice on the text of the 
desired thought; in this case, “camp.”

Click Quick Takes.

Type: "Bitten by wasps,” press ENTER.

Type: "Rode horse,” press ENTER.
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Creating a Brainstorm Diagram
What You See: The second level of thoughts.

6. To end Quick Takes, click the Quick Takes button again. 
The thunderbolt disappears.

7. Automatically arrange the thoughts. Click the Arrange 
button (large oval with three small ovals attached) in the 
palette. 

What You See: Thoughts arranged nicely. Notice the links 
from the main thought (“vacation”) to the sub-thought (“camp”) 
and its details, indicating the multiple levels of information.
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8. Suppose you want the sublevel information to have 
different shapes and colors.

Click a thought: “hiking.”

From the palette, click the rectangle to change the shape.

9. To change the color, click the Fill Color button (oval with 
the color bar).

In the color dialog, pick Green, then click OK.

10. Change the properties of the other two thoughts at the 
same time: 

To select multiple objects, drag-select over them until they 
are inside the selection frame.

Click the Rectangle button. Next, click the Fill Color 
button, pick the Green, then click OK.

What You See: Second level thoughts with new shape and 
color.
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11. What if you decide to reorganize your thoughts? For 
instance, you want to have the “camp” details be the details 
for “farm.”

Remove the existing links: Select each link and click the 
Delete button. (You could also drag-select both links at 
once.) A selected link has a small frame at each end. 

Move the details: drag-select the two thoughts “bitten...” 
and “rode...,” and move them so that they are below “farm.”

Create new links by doing the following:

Click the Link button (two ovals with a link). 

Select the originating thought, “farm,” then select the 
target thought, “bitten by wasps.” 

Repeat to link “farm” and “rode a horse.”

Tip: If a link is not visible, select its thought and move it 
until the link is showing.

End Link mode by clicking the Link button.
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Chapter 9. Writing Path
What You See: The reorganized Brainstorm diagram.

12. Save As “My Brainstorm” and continue to More to Explore 
or Close the file. 

Tips:
• If you make a mistake, use Undo from the menu or 

CTRL+Z.

• Use the Delete button in the palette for objects in the 
diagram. For editing text, use the Delete key, 
CTRL+X, or Cut from the menu.
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More to Explore: Adding Brainstorm Notes
When brainstorming, it's best to use short phrases for your thoughts. 
If you have elaborations, or quotes or source information, a 
Brainstorm Note is the best place to hold those thoughts. 

1. Open “My Brainstorm” from the previous exercise if it isn’t already 
open.

2. Select the thought you want to attach the Note to.

3. Click the Note button in the Brainstorm palette. 

4. In the Note window type your note. You can use familiar editing 
functions in the Note window.

5. Close the Note window.

6. To open a Note, select the thought, then click the small Note 
marker attached to it.

7. Save and Close the file.

Note: Follow these steps to add Outline Notes; the only difference is 
the marker.
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Creating an Outline 
Outline is a text-based, hierarchical organizer and is one of the two 
ways you can formulate your writing plan. By default, it uses the 
Roman Numeral outline style.

Brainstorm, Outline and Draft, as part of the Kurzweil 3000 Writing 
Path, share the same information that can be viewed in different 
modes. Changes you make in one are reflected in the other.

You can bring content into the Outline in a few ways:

• Start in Brainstorm, then switch to Outline view.

• Go directly from reading and note taking to writing by using 
Extract Column Notes to Outline.

• Copy and paste or drag and drop text from other sources.

This exercise lets you explore the following:

• Creating an outline from scratch, including changing levels 
and reorganizing topics.

• Switching back and forth between Brainstorm and Outline.
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What You’ll Need to Do This Exercise: Writing toolbar showing.

1. With no documents open, go to the Writing toolbar and 
click the Outline button.

What You See: Default topic with the Outline tools palette.

2. Replace the default text with your first topic:

Select the text and type: “China Exchange.”

3. To create another topic at the same level, either click Topic 
(first button) in the palette or press CTRL+G. 

Type: “History.”

4. Continue adding topics at the same level. CTRL+G again, 

Type: “Selecting the Sister School;” press CTRL+G again.

Type: “2008 Trip.”

What You See: Outline with first level topics.
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5. To create a subtopic or detail:

Select the topic that you want to expand by clicking on its 
number: “II. History.” (The line of text should highlight.)

Then either click Subtopic (second button) or press 
CTRL+K.

And type: “The idea.”

6. Continue adding topics at this same level, press CTRL+G. 

Type: “Exploratory Trip.”

CTRL+G again to create another one.

Type: School's OK.

7. Create details.

Be sure the cursor is placed in the topic, “C. School’s OK” 
and press CTRL+K.

Type: “Presentation.”

8. Add another topic at this level, press CTRL+G.

Type: “Proposal.”

What You See: The outline so far.
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9. What if you change your mind? You now want the sub-
topic, “School’s OK,” to be under “III. Selecting the Sister 
School.”

To select a topic line, click on its number, in this case, “C.”

Copy and Paste it into the “IV. 2008 Trip” line to insert it 
above that line.

To demote or move a topic down one level: select it and 
click the Right Arrow. (To promote a topic, use the Left 
Arrow.)

What You See: The final outline. The minus sign indicates that 
the topic has subtopics or details. Click it to show/hide details.

10. Save As “My Outline.” Continue to the next exercise or 
Close the file.
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Switching Between Brainstorm and Outline
Recall that Brainstorm and Outline are part of the Kurzweil 3000 
Writing Path and share the same information that can be viewed in 
their different modes. Changes you make in Brainstorm or Outline are 
reflected in the other.

You can start your writing plan in either, then switch back and forth 
between Brainstorm and Outline as you create your writing plan.

In this exercise you have the opportunity to explore the following:

• Switching back and forth between Outline and Brainstorm.

• Using Zoom, Select All and move functions in Brainstorm.
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What You’ll Need to Do This Exercise: 
• “My Outline” from the previous exercise.

• Reading and Writing toolbars showing.

1. Open “My Outline” if it isn’t already open.

2. Click the Brainstorm button.

3. If there are objects outside of the view, click the Zoom Out 
button in the Reading toolbar. Zoom to 70%.

4. Make room to move objects: Select All the objects in the 
diagram by pressing CTRL+A, then drag and drop the 
diagram farther down in the window, creating enough 
space to place one shape at the top of the diagram.

5. Make a thought the main topic: 

Select “China Exchange” and move it, centered above the 
entire set.
148



Chapter 9. Writing Path
6. Connect the main topic to the subtopics:

Click the Link button in the palette.

Select the main topic, “China Exchange,” then select 
“History.”

Select the main topic again, then click “Selecting Sister 
School.”

Select the main topic again, then click “2008 Trip.”

End Link mode by clicking the Link button again.

What You See: The main topic linked to the subtopics.

7. Click the Outline button to go to Outline view.
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What You See: “China Exchange” is now the main topic.

8. Modify the Outline: Click on the word “China” and replace 
it with the word “Russia.”

9. Click the Brainstorm button to go to Brainstorm view.

What You See: The change you made in Outline is now 
updated in Brainstorm.

Tip: If any shapes are overlapping, click the Arrange button in 
the palette.

10. Save (optional) and Close the file.
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Creating an Outline from Column Notes
An expedient way to go from Reading to Writing is to take notes using 
the Color Highlighters while you read and do your research, Extract 
Highlights to Column Notes, then Extract Column Notes to Outline 
when you are ready to begin writing.

This exercise gives you the opportunity to create an outline from an 
existing Column Notes file. 

What You’ll Need to Do This Exercise: 
• An existing Column Notes file, “My Column Notes,” that you 

created in the previous chapter.

• Main and Writing toolbars showing.

1. Open the Column Notes file:

Open a document; clicking the New button in the Main 
toolbar will do.

Click the Column Notes button.

In the Open Column Notes dialog, select Using an 
Existing Note File.

In the Choose a Column Notes File dialog, select “My 
Column Notes,” and click Open.
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What You See: Open Column Notes file.

2. From the File menu, choose Extract Column Notes to 
Outline.

What You See: The column notes in Outline mode.

3. The outline is all set to use in a Draft, which is the topic of 
the next exercise. Save As “My Notes Outline,” then click 
the document Close button.
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Creating a Draft from Outline 
The Draft is where all your efforts in brainstorming, and outlining and 
planning all come together. This is where you put your thoughts into 
prose.

The Draft is basically a text document in .KES format. You can use all 
the editing features available in Kurzweil 3000, including Word 
Prediction, Word Lists and Spell Checking.

There are a few ways to start a Draft:

• Click Draft, which opens a blank text document, and begin 
writing.

• From Brainstorm or Outline view, go to the Write menu and 
choose to open a Draft New From Outline.

• Or from Brainstorm or Outline view, click the Split View 
button in the Writing toolbar.

This exercise will take you through the following:

• Opening a Draft from the Write menu.

• Opening a Draft in Split Screen view.
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What You’ll Need to Do This Exercise: 
• Existing Brainstorm or Outline: “My Brainstorm” and “My 

Outline” from previous exercises. (You could also use “My 
Notes Outline;” be aware that the illustrations in this exercise 
show results of using “My Brainstorm” and “My Outline.”)

• Main and Writing toolbars showing.

1. Open a file that contains a Brainstorm diagram or Outline 
(recall that Brainstorm and Outline share the same 
information, therefore, you can open a draft from either 
one):

Click the Open button in the Main toolbar, then select and 
open “My Brainstorm.”

2. Create a Draft from Brainstorm or Outline:

From the Write menu, select Draft New from Existing 
Outline.

What You See: All the information from the outline is 
presented in the Draft, ready for you to expand into prose. 

If you like working within an outline as you write, this is an ideal 
method to go from outline to draft.
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3. Expand a thought into a sentence:

Click in a line and begin typing.

The Draft is like any other Kurzweil 3000 text document. 
You can use all the familiar editing tools, including Word 
Prediction and Spell Checking.

What You See: Draft with an outline topic expanded into 
prose. 

For those of you who would rather see the outline as you work 
in a draft, this next method will work for you.

4. Open “My Outline.”

5. Click the Split Screen view button in the Writing toolbar. 

Now you have both the outline and a blank draft in one 
place. The outline in the left pane and the draft in the right. 

Tip: To get a better view of the outline, resize the pane by 
dragging the vertical border between the two panes or 
scroll using the scroll bar.
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6. Begin writing in the Draft pane.

Drag and drop text from the left pane to into the right pane.

Expand a thought into prose.

What You See: Split Screen view with outline in left pane. In 
the right Draft pane, you see text dragged and dropped in and 
a subtopic expanded into prose.

7. Save As “My Draft” and continue to the next exercise or 
Save and Close the document.
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Using the Review Check List 
At any time while you are in the drafting stage, you can display a 
Review list to help you keep track of what you should be reviewing.

It gives you some tasks to do to finalize your draft. When you have 
finished each task, simply check it off in the list. 

Kurzweil 3000 maintains the status of your list, so you can go ahead, 
save your document, take a break and continue where you left off the 
next time.

In addition, this list is customizable (in the Tools Options dialog) so 
teachers and/or students can add, remove or rename items. For 
details, go to online Help.

What You’ll Need to Do This Exercise: “My Draft” document from 
the previous exercise.  

1. Open “My Draft” if it isn’t already open.

2. From the Write menu, choose Review.

What You See: Review checklist and draft in split screen view.

3. When you finish a review task, click its check box.

4. Save and Close the document. The next time you open it, 
the list shows where you left off.

Tip: If you are doing multiple iterations of a draft, consider 
giving different names for each version. That way, you can 
complete multiple rounds of the review tasks.
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10 Writing and Self-
Correction Tools

In this chapter, you’ll learn about:

• Writing and Editing in Kurzweil 3000 on page 160.

• Creating a Text Document and Hearing What You Type on page 
161.

• Using Word Prediction and a Homophones List on page 162.

• Using Floating Word Lists on page 166

• Spell Checking a Document on page 169

• Finding Homophones on page 171.
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Writing and Editing in Kurzweil 3000
Kurzweil 3000 provides a wide range of features to assist with writing 
tasks:

• Notes and Highlighter tools are useful in taking notes and 
marking main ideas and supporting details during the reading 
and research phase. See Chapter 5, Notes and the Creation of a 
Study Document on page 73. See Chapter 6, Color Highlighters as 
Study Tools on page 91.

• The Extract command is a powerful tool for creating 
summaries and outlines that aid in studying and mastering 
material and in the composition stage. See Chapter 6, Color 
Highlighters as Study Tools on page 91.

• Reference tools are also accessible while writing and editing. 
See Chapter 4, Reference Tools on page 59.

In this chapter, you’ll work with Speak as Typing, Word Prediction 
and Homophones list and use some typical editing functions such as 
dragging and dropping text and images and spell checking. 

To show the Writing toolbar:
To do the exercises in this chapter, you must have the Writing toolbar 
showing.

Click the blue Toggle along the left edge of the Kurzweil 3000 toolbar 
area to show or hide the Study Skills toolbar. You can also use the 
shortcut keys CTRL+SHIFT+F12.

The blue Toggle shows or hides the Writing toolbar
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Creating a Text Document and Hearing What 
You Type
When you type your own document in Kurzweil 3000, you are creating 
text that Kurzweil 3000 can read back to you.

1. Click the New button in the Main toolbar to open an empty 
document.

2. Type words and a couple of full sentences. Include spaces 
and punctuation.

You can use Kurzweil 3000 just like any text editor or word 
processor.

What You See: What you type appears in the document 
display area of the Kurzweil 3000 window.

What You Hear: By default, Kurzweil 3000 reads back whole 
words after you press the space bar, and whole sentences 
after you enter a period and press the space bar.

3. Save the document and continue to the next exercise.
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Using Word Prediction and a Homophones List
As you type, Word Prediction helps you to complete words or to select 
the next word from a list of possibilities. 

In addition, there is a comprehensive set of Word List features for 
building, editing and enabling whatever word lists your curriculum 
requires. Kurzweil 3000 comes with a set of lists, such as 
Homophones and Confusables, as well as a group from Sopris West 
Step Up to Writing®, including Action Verbs and Transitional Words.

For more information on the Word List features, see Kurzweil 3000 
online Help.

In this exercise, you’ll learn how to insert a word from the Word 
Prediction list and how to use homophone words in Word Prediction.

What you’ll need: 

• The Writing toolbar showing: Click the blue toggle along the 
left edge of the toolbar area, or press CTRL+SHIFT+F12.

• An open text document in which you can type and edit, such 
as the one you created in the previous exercise.
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1. Click the Word Prediction button.

What You See: The Word Prediction dialog.

Notice the thumbtack in the upper-left-hand corner. By default, 
this dialog is stationary. To have it move as you type, click the 
thumbtack.

2. Begin typing “Type some text.”

Click the 
Thumbtack to 
have the dialog 
move with text as 
you type.
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What You See: The Word Prediction dialog with a list of 
suggestions for the word you are typing. 

Notice that the word “some” in the list is highlighted. This 
means that it is an entry in the Homophones list.

3. Double-click the highlighted word.

What You See and Hear: The Homophone dialog containing 
the word’s related homophones. Kurzweil 3000 spells and 
reads the definition of the word while highlighting.
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4. To see and hear another homophone definition, click on it.

5. When you’re done, click the dialog Close button.

6. To insert one of the suggestions, click the number next to 
the desired word.

7. When you’re done with Word Prediction, click the dialog 
Close button.

8. Continue to the next exercise. If you need to end here, click 
the document Close button. 
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Using Floating Word Lists
Once you have Word Lists set up, you can use the Floating Word List 
feature during the writing, editing and review process to:

• Encourage or require the use of words from a Word List.

• Check any text document for words used from Word List.

For information on setting up Word Lists, go to online Help or Creating 
a Word List by Extracting Words on page 175.

To do this exercise, you should have the Main and Study Skills 
toolbars showing.

1. Open a text document; clicking New from the Main toolbar 
is fine.

2. Click the Word List button in the Study Skills toolbar.

If this is the first time you are using the feature, the Edit 
Word List dialog opens.
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3. To set up Word Lists for the floating window, select some 
lists from the All Word Lists area: 

Click Confusable 1.

Control-click to select three more: Homophones 1, 
Narrative Transitions, Strong Verbs.

You may have to scroll down.

Click Add as Required.

The lists appear in Selected Word Lists area.

Click Highlight Used Words, a very handy option that 
helps you track the words from a Word List that you have 
used in your writing.

Click OK.

What You See: The Floating Word List dialog in the 
document.
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Using Floating Word Lists
4. Click inside the document window and type: “By the time 
we get to the stop the break dose not squeak.”

5. To see if you have use any words from the Word Lists, go 
to the Floating Word List window and:

Click the Homophone tab. Scroll through to see the words 
in this list that you used in your document.

Click the Confusable tab. 

6. Close the document.
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Spell Checking a Document
Kurzweil 3000 spell checker works in text as well as in image 
documents. See Kurzweil 3000 online Help for information about spell 
checking in image documents under Editing Image Documents.

What You’ll Need to Do This Exercise: A text document open.

1. Click where you want to start spell checking, then click the 
Spell Check button in the Writing toolbar.

What You See: If Kurzweil 3000 finds a word it thinks is 
incorrect or isn’t in the dictionary, the Spelling Correction 
dialog appears. 

Note: The words you see in your dialog will be different from 
the example below.
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Spell Checking a Document
2. Decide how you want Kurzweil 3000 to handle each error 
it finds. Try the following options:

To ignore the possible error, click Skip to skip this instance 
or Skip All to skip all instances.

To correct an error, select a word in the Suggestions list 
or type your correction into the Change To box. Click 
Change to change this instance or Change All to change 
all instances.

To hear the contents of the Change To box, click Read.

To add the word to your spelling dictionary, click Add.

3. When you’re done, click the Exit button in the Spelling 
Correction dialog.

4. Close the document.
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Finding Homophones
Another helpful self-correction tool is Find Homophone, accessible 
from the Edit menu.

For this exercise, try using the document, “Horse’s Tale” from the 
"Sample Documents" folder. The examples in this exercise are from 
that document. 

1. Click where you want to start the find; from the Edit menu, 
choose Find, then Homophone II.

What You See: If Kurzweil 3000 finds a word in the document 
that is a homophone, the Homophone dialog appears. 

If you’re using the “Horse’s Tale” document, the first 
homophones Kurzweil 3000 finds are “tale” and “tail.”
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Finding Homophones
2. To hear Kurzweil 3000 spell a word and read its definition, 
click the word.

To find the next homophone, click Find Next 
Homophone.

To find the next instance of the homophone, click Find 
Next “Tale.”
Note: In a text document, the Replace button is active. 
Click it to replace the current word with a homophone from 
the Homophone dialog.

3. When you’re done, click the dialog Close button.

4. Close the “Horse’s Tale” document.
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11 Word Lists

In this chapter, you’ll learn about:

• Kurzweil 3000 and Word Building on page 174.

• Creating a Word List by Extracting Words on page 175. 

• Setting Options for a Word List on page 179.

• Finding a Word List’s Words on page 181.

• Disabling a Word List on page 182.
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Kurzweil 3000 and Word Building
Kurzweil 3000 and Word Building
If weekly vocabulary-building lists and word lists based on subjects or 
units of study are integral parts of your curriculum, the Kurzweil 3000 
Word List feature can help you automate the process of creating your 
lists, while enabling your students with special needs to access and 
use the lists within Kurzweil 3000. 

With this feature, you can create, edit, and enable or disable lists as 
well as add lists to Word Prediction and the Find and Highlight menus. 
And once you save a list, it is available for the Floating Word List 
window. See Using Floating Word Lists on page 166.

If you went through the writing and editing exercises in the previous 
chapter, you have already been introduced to a Kurzweil 3000-
provided list, the Homophones list.

In the following exercises, you’ll extract words from a document to 
create a word list, enable the list and see how the list works as a 
student is working with Kurzweil 3000.
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Chapter 11. Word Lists
Creating a Word List by Extracting Words
You can create a word list in Kurzweil 3000 in a few ways:

• By editing an existing list and renaming it.

• By extracting all the words from a document.

• By extracting words that you’ve highlighted in a document.

In this exercise, you’ll walk through extracting all the words in a 
document. 

What You’ll Need to Do This Exercise: The “Time Travel” document 
from the "Sample Documents" folder.

1. Open the document from which you want to extract words 
for a new Word list.

2. From the Tools menu, select Setup Word Lists.

What You See: The Word Lists dialog.

3. In the Word Lists dialog, click New.
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Creating a Word List by Extracting Words
What You See: The New Word List dialog.

4. In the New Word List dialog, click Create Word List from 
“Time Travel.kes.”

5. Click the Extract all words option.

6. Click Next.
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Chapter 11. Word Lists
What You See: The next New Word List dialog containing the 
list of extracted words.

Notice that all the words in the document, including common 
words such as “an” and “be,” are in the list. It’s possible to 
remove those words, as you’ll do next.

7. In the New Word List dialog, select Common English 
words, then click Remove.

What You See: Some words from the Words in list area are 
now in the Words removed from list area.

8. To remove a word from the list, select it from the Words in 
list area, then click the Right arrow button.

To return a word to the list after removing it, select it from 
the Words removed from list area and click the Left arrow 
button.
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Creating a Word List by Extracting Words
9. When you’re done, click Next.

What You See: The Save As dialog.

10. Type a new file name for the word list: “Science Unit 3.”

11. Click Save.

What You See: The Word Lists dialog now contains the new 
list. 

12. Click the new list’s check box to enable it, then click Apply.

13. Click OK.

14. Continue to the next exercise.
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Setting Options for a Word List
You can set a number of options for a Word list. For complete details, 
see Kurzweil 3000 online Help.

In this exercise, you’ll make the “Class Word List” you created in the 
previous exercise available on the Find menu so that students can 
find the words as they read.

1. From the Tools menu, select Setup Word Lists.

2. In the Word Lists dialog, ensure that the Class Word List 
check box is checked. Then click Options.

What You See: The list’s Options dialog.

3. Click Add this list to the Find Menu to have Kurzweil 
3000 add the list to the Find menu.
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Setting Options for a Word List
4. Click OK to close the dialog.

5. Click Apply, then click OK in the Word Lists dialog.

6. To take a look at the results, continue to the next exercise.
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Finding a Word List’s Words
Once you create or enable a Word list, it’s ready for students to use as 
they read in Kurzweil 3000.

For this exercise, open the “Time Travel” document from the "Sample 
Documents" folder.

1. From the Edit menu, choose Find, then select Science 
Unit 3.

Note: You can also find homophones in any document in the 
same way.

What You See: Kurzweil 3000 highlights the first word it 
encounters from the Word list and opens the Find dialog. 

2. To find the next word from the list, click Find Next <name 
of the list you are using>.

To find the next instance of the currently highlighted word, 
click Find Next <word>. 

3. When you’re done, click the Close button to close the Find 
dialog.

4. Close the “Time Travel” document.
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Disabling a Word List
Disabling a Word List
When your student or class moves on to another week’s or unit’s 
words, it’s easy to disable the old Word list: From the Tools menu, 
select Setup Word Lists. In the Word Lists dialog, deselect or click 
to uncheck the list’s check box, then click OK.
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12 Test Document 
Preparation

This chapter is primarily for teachers whereas the next 
chapter is for students. 

If you are a teacher, we recommend that you go through the 
next chapter to familiarize yourself with the features 
students use to take tests in Kurzweil 3000. That way, you 
can also train your students on test taking in Kurzweil 3000. 
If your students are older and capable, have them go 
through the next chapter by themselves.

In this chapter, you’ll learn about:

• Preparing Tests on page 185.

• Using Fill in the Blanks on page 186.
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• Customizing Kurzweil 3000 for Test Taking on page 187. 

• Selecting the Test Taking Toolbar on page 188.

• Saving the Toolbar with the Test Document on page 189.

• Locking Features on page 191.
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Preparing Tests
With Kurzweil 3000, it’s easy to prepare and administer tests, to 
accommodate a wide range of student abilities and to provide 
performance feedback. 

In preparing a test, start by doing one of the following:

• Scanning a document. See Scanning a Document into Kurzweil 
3000 on page 31.

• Opening a document from another application. 

• Creating a document from scratch in Kurzweil 3000 using the 
writing editor. See Creating a Text Document and Hearing What You 
Type on page 161.

• Creating annotations containing questions in a document, 
then using the Extract feature to build a new document with 
the questions ready to apply as a test. See Creating a Study 
Document by Extracting Notes on page 85.

Kurzweil 3000 can handle different types of tests including:

• Multiple Choice: Have students use color Highlighters, text 
Circle tools, Text Notes or drag and drop.

• Essay: Put an empty Text Note in the test as a starting place 
for the students.

• Fill in the Blanks (and True or False): Use the Fill in the 
Blanks feature as described in the following exercise.
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Using Fill in the Blanks 
You can use this feature for Fill-in-the-Blank or True or False tests, 
worksheets, forms and applications.

Note: This feature only works with black and white image documents, 
and on one page at a time.

What You’ll Need to Do This Exercise: Open the “Time Travel Quiz” 
document from the "Sample Documents" folder, and Save and 
rename it “my Time Travel Quiz.”

1. From the Tools menu, select Fill in the Blanks or click the 
Blanks button.

What You See: An empty Text Note at every blank line. 

2. Save the document. “my Time Travel Quiz” is now ready 
for students to use in the next chapter. 
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Customizing Kurzweil 3000 for Test Taking
There are two main reasons why you would want to customize 
Kurzweil 3000 features for test taking:

• To turn off certain features that students will not need or that 
will distract them.

• To accommodate students who have special challenges.

The following is a short list of some of the features that you can use to 
customize Kurzweil 3000 to easily accommodate students’ 
requirements for regular use as well as for test taking. 

• Change the Reading Speed from the Reading toolbar.

• Turn Speak as Typing on or off as a proofreading tool. 

• Show or hide certain toolbars. 

• Save toolbar(s) with a document.

• Use annotations to embed helpful hints. 
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Selecting the Test Taking Toolbar
The sample toolbar sets are designed for specific learning tasks. In 
testing, you may want to select the Test Taking toolbar set for its 
reduced set of tools. Students can adjust reading speed and enlarge 
text for test-taking comfort, while having access to the Highlighters for 
highlighting multiple choice answers.

Note: When customizing settings for a student using the Kurzweil 
3000 Standalone edition, make the changes on the Kurzweil 3000 
system he or she will be using. 

For now, try applying the Test Taking toolbar set. 

You can find all the other ways to customize Kurzweil 3000 for test 
taking, including disabling features and customizing toolbars, in 
Kurzweil 3000 online Help.

1. Place the cursor in the toolbar area of the Kurzweil 3000 
window, then press the right mouse button.

2. Choose Apply Toolbar Set, then select Test Taking.

What You See: The Test Taking toolbar.

Note: To revert to the default Kurzweil 3000 Main toolbar, 
select Classic from the Apply Toolbar Set menu.
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Saving the Toolbar with the Test Document
Saving a toolbar with a test document can be beneficial for students 
taking a test using Kurzweil 3000. All the tools they need can be on 
the toolbar, saving time and helping students focus on the test content 
rather than on finding the tools they need.

What You’ll Need to Do This Exercise: The Test Taking toolbar set 
applied and displaying in the “my Time Travel Quiz” document. 

1. Have the desired test document open.

2. From the File menu, select Properties.

What You See: The Document Properties dialog.

3. In the Document Properties dialog, click General
Kurzweil 3000 for Windows Tutorial 189



Saving the Toolbar with the Test Document
4. Select Save Toolbars in Document.

5. Click OK.

6. If you close and re-open the document, the Test Taking 
toolbar should be in the toolbar area.

7. Continue to the next exercise if you want to learn how to 
lock features.
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Locking Features
You can lock or password-protect various features either to 
accommodate specific student requirements or for test taking. By 
default, all features are available to users. When you lock features, it 
affects only the machine on which you performed the lock. In addition, 
it’s possible to save locks to a document.

See Kurzweil 3000 online Help for information about password 
protection and saving locks to a document.

In this exercise, you’ll turn some features off.

What You’ll Need to Do This Exercise: The “my Time Travel Quiz” 
document from previous exercises open in Kurzweil 3000. The Test 
Taking toolbar should be displaying.

1. Take a look at the Test Taking toolbar.

What You See: The Test Taking toolbar. Notice that the Word 
Prediction and Spell Check buttons are in enabled state.
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Locking Features
2. From the Tools menu, choose Lock Features.

3. Click Writing in the left column to display the Writing 
pane.

What You See: The Lock Features Writing pane.
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Chapter 12. Test Document Preparation
4. Select Disabled for the Word Prediction and Spell 
Check options.

5. Click OK.

What You See: In the Test Taking toolbar, the Word 
Prediction and Spell Check buttons grayed out.

6. Repeat the above steps to re-enable the features.

7. Close the document. Go to the next chapter to learn how 
to take a test in Kurzweil 3000.
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13 Test Taking 

This chapter is primarily for students. Teachers, however, 
can go through and train students on the material. In this 
chapter, you’ll learn about:

• Test Taking Using Kurzweil 3000 on page 196.

• Reading Through the Test on page 197.

• Filling in Your Name on page 198.

• Using Fill in the Blanks on page 199.

• Using the Text Circle Tool for Multiple Choice on page 200.

• Dragging and Dropping an Answer on page 202.

• Reading Back Test Questions and Answers on page 204.

• Saving Your Test Document on page 205.

• Printing Your Test on page 205.
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Test Taking Using Kurzweil 3000
Before you take a test, find out what type of test it will be: Fill in the 
Blanks, Multiple Choice, True or False, Essay or a combination. Find 
out what Kurzweil 3000 tools you will be allowed to use.

When you use Kurzweil 3000 to take a test, be sure to read the test 
before answering the questions and read it again after you’ve 
completed the test to make sure your answers are correct. 

For exercises in this chapter, use “my Time Travel Quiz,” prepared in 
the previous chapter. If you are a student, see your teacher for this 
document.
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Chapter 13. Test Taking
Reading Through the Test
The document “my Time Travel Quiz” should be open.

1. Click at the very beginning of the document, and click the 
Read button.

2. Click the Pause button to stop reading at any time.

3. Continue to the next exercise to fill in your name.
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Filling in Your Name
The document “my Time Travel Quiz” should be open.

1. In the Name line, look for a little orange box. This is a Text 
Note.

2. Click the box and type your name. 

If you make mistakes, you can correct them by using the 
Backspace key. You can also use the Read button to read 
what you have typed.

3. Continue to the next exercise to fill in answers.
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Using Fill in the Blanks 
The document “my Time Travel Quiz” should be open. 

In this exercise, you will work with the True or False section of the 
document, starting with question 1. 

Tips: 
• To navigate among the notes, use the TAB key to go forward, 

and SHIFT+TAB to go backward.

• For short answer or essay responses, you can use ENTER to 
go to another line, CTRL+X to cut, and CTRL+C to copy and 
CTRL+V to paste text in Kurzweil 3000 Text Notes.

• You can also have Kurzweil 3000 read what you have written.

1. In question 1, find the Text Note box above the line.

2. Click inside the box.

3. Type “F” or “False.”

4. If you want more practice, continue to the next questions 
and fill in answers in the same way.

5. When you are ready, continue to the next exercise.
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Using the Text Circle Tool for Multiple Choice 
In this exercise, you will work with Question 8 in the Multiple Choice 
section of the document and use a Text Circle tool to select answers. 
Note that you could do the same task with a Highlighter.

What You’ll Need to Do This Exercise: 
• The document “my Time Travel Quiz” should be open. 

• Having the Test Taking toolbar set showing would be very 
helpful. To show the Test Taking toolbar set, place your 
pointer in the toolbar area, press the right mouse button to 
open the Toolbar shortcut menu, and select Test Taking.

The following is the Test Taking toolbar set.

1. In the “my Time Travel Quiz” document, press the Page 
Down key until you see question 8.

2. Click the Circle tool in the Test Taking toolbar.
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3.  In question 8, drag the Circle tool over the correct answer, 
“physicist.”

What You See: A circle around the answer.

4. When you are done, click on the Circle tool button again.

5. Continue to the next exercise.
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Dragging and Dropping an Answer
You can also drag and drop your answers. 

You should have the document “my Time Travel Quiz” open.

In this exercise, you will work with question 9 at the top of the next 
page in the document.

1. Press the Page Down key from page 1 until you see 
question 9.

2. Select an answer:

From the word list, double-click on the word “relative.”

What You See: The selected word is highlighted.

3. Drag and drop the answer:

Place the mouse cursor on the word.

Press and hold down the left mouse button and move the 
text to the answer line in question 9.

Then release the mouse button.
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Tip:
Dragging and dropping text also works for True or False, Fill in the 
Blanks and Essay responses if part of the answer is on the test, or 
if your teacher allows you to use a study document that might have 
the answer on it.

What You See: The word is on the answer line.

4. When you are done, continue to the next exercise.
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Reading Back Test Questions and Answers
When you have completed a test, always go back and check your 
answers. 

1. Click at the beginning of the test or click inside the Answer 
(Text Note) you want to check.

2. Click the Read button.

If you left a blank line, Kurzweil 3000 will pause. 

3. Correct any wrong answers.
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Saving Your Test Document
Remember to save your test document often as you work.

Click the Save button .

Printing Your Test 
It’s a good idea to print your test document when you are done. You 
may also need to print it to hand it in to your teacher.

Click the Print button  in the toolbar area.

Congratulations
You’ve just learned how to take a test using Kurzweil 3000. 
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Kurzweil 3000 
Scanning Sample

Rikki Tikki Tavi by Rudyard Kipling

At the hole where he went in
Red-Eye called to Wrinkle-
Skin.
Hear what little Red-Eye 
saith:
"Nag, come up and dance 
with death!"
Eye to eye and head to head,
(Keep the measure, Nag.)
This shall end when one is 
dead;
(At thy pleasure, Nag.)
Turn for turn and twist for 
twist--
(Run and hide thee, Nag.)
Hah!  The hooded Death has 
missed!
(Woe betide thee, Nag!)

This is the story of the great war that Rikki-
tikki-tavi fought single-handed, through the 
bath-rooms of the big bungalow in Segowlee 
cantonment. Darzee, the Tailorbird, helped 
him, and Chuchundra, the musk-rat, who 
never comes out into the middle of the floor, 
but always creeps round by the wall, gave 
him advice, but Rikki-tikki did the real fighting.

He was a mongoose, rather like a little cat in 
his fur and his tail, but quite like a weasel in 
his head and his habits. His eyes and the end 
of his restless nose were pink.  He could 
scratch himself anywhere he pleased with 
any leg, front or back, that he chose to use. 
He could fluff up his tail till it looked like a 
bottle brush, and his war cry as he scuttled 
through the long grass was: "Rikk-tikk-tikki-
tikki-tchk!"
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shortcut (right mouse button) menus 15
showing and hiding

Notes 84
Outline subtopics and details 146
toolbars 14
toolbars for test taking 187

Speak as Typing 187
Spell Check button 169
spell checking 169
Spell Word 62
Split Screen View 134
starting

Kurzweil 3000 9
reading 52

Sticky Note
button 78
creating 78
reading 80, 82

stopping reading 52
study guides, creating 85
Study Skills toolbar 14, 76, 92, 120, 
123, 127
studying

reading by Highlights 95
using Column Notes 129
using extracted summary 96

summaries, creating 85, 96
switching

between Brainstorm and Outline 
135

T
taking notes

across documents 127
using color highlighters 121

test taking
about 196
customizing Kurzweil 3000 for 187
dragging and dropping answers 

202
filling in answers 198, 199
locking features 191
preparing tests 185
reading back answers 204
reading the test 196, 197

Test Taking (Sample) toolbar set 188
Test Taking toolbar set 16, 200
tests

essay 185
fill in the blanks 185, 186
multiple choice 185
true or false 185

Text Answer Bubble Note 103
Text Circle tools 200
text documents 20
Text Note

button 79
creating 79
reading 80, 82

Tile Vertically 66
Tip of the Day 11
Toggle(s)

about 10
Main toolbar 14
Reading toolbar 14
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Study Skills toolbar 14, 76, 92
Writing toolbar 14, 160

Toolbar
area 10
shortcut/right mouse button menu 

15, 16
Toggles, about 10, 14

toolbars
applying 16
Document Preparation 49
Kurzweil 3000 default, Classic 16
Main 13
Reading 13, 54
Sample 188
saving with a document 189
showing and hiding 14
Study Skills 14, 76, 92, 120, 123, 

127
Test Taking 16, 200
Writing 14, 136, 154, 160

U
underlying text

about 27
changing a word in 46

V
View Annotations 84

W
window display

Tile Vertically 64, 66
Word Lists

about 174
creating by extracting words 85, 

175
disabling 182

finding words in 181
in Floating window 166
options 179
setting up 179, 182

word prediction 162
writing in Kurzweil 3000 120, 134, 160
Writing Path

about 134
Brainstorm 134
buttons on the Writing toolbar 134
Draft 153
Outline 134
Review 157

Writing toolbar 14, 136, 154, 160

Z
Zone Edit mode 37
zone editing 35
Zone Editor 33, 35, 41
Zone Properties 39, 41
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about 28
re-ordering 35

Zoom
in Brainstorm 148
in documents 23
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